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Ascend Customer Service

 

You can request assistance or additional information via Email, the Web, or using 
the telephone.

 

Obtaining Technical Assistance

 

If you need technical assistance, first gather the information that Ascend 
Customer Service will need for diagnosing your problem. Then select the most 
convenient method of contacting Ascend Customer Service. 

 

Information you will need

 

Before contacting Ascend Customer Service, gather the following information:

• Product name and model

• Software and hardware options

• Software version

• Type of computer you are using

• Description of the problem

 

How to contact Ascend Customer Service

 

 Ascend's Advantage Online Support (AOS) is available free of charge for access 
to technical information on IntragyAccess.

 

Web

 

Please visit Ascend AOS on the web at:

http://www.ascend.com/aos/

 

Email

 

Send an Email to Ascend technical support describing your system and the 
problem using this address:

Intragyhelp@ascend.com 
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Phone

 

Should live technical assistance be required, Ascend offers technical support for 
IntragyAccess on a per call basis via fee based 900 service provided by AT&T. 
Should you have the need for technical assistance, please call:

 1-900-555-ASND (2763)

The per minute rate for technical assistance is $2.95. Charges for technical 
assistance do not begin until you are connected to an Ascend Network Support 
Engineer. All charges will be billed directly to your telephone bill.

 

Need information about new features and products?

 

Ascend is committed to constant product improvement. You can find out about 
new features and other improvements as follows:

• For the latest information about the Ascend product line, visit our site on the 
World Wide Web:

http://www.ascend.com

• For software upgrades, release notes, and addenda to this manual, visit our 
FTP site:

ftp.ascend.com
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About this guide

 

How to use this guide

 

This manual is organized into the following sections:

This manual also includes a glossary and an index.

 

Section Description

 

Installation How to install IntragyAccess and choose the 
various installation options

Terminal Emulation Terminal emulation including telnet and serial 
connections

Electronic Messaging Sending and receiving mail messages and mail 
management

File Transfer and Sharing File Transfer Protocol (FTP) server and client as 
well as Network File sharing (NFS)

Using and Maintaining 
Hotlists

Using the Hotlists to save frequently used 
sessions for Mail, Terminal, FTP, and Web.

Miscellaneous Services Using various network utilities included with 
IntragyAccess. These utilities include, Ping, 
Finger, Whois, HostLookup, and TraceRoute.

Network Printing How to use IntragyAccess in the Windows 95 
environment as an LPR Client and LPD Server

Appendixes How to use DeskDial
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What you should know

 

IntragyAccess includes networking software to perform basic business tasks such 
as terminal emulation, file sharing, sending and receiving mail, and printing via 
networks. You should have a basic knowledge of net etiquette and also the basic 
uses of each of IntragyAccess components.

 

Documentation conventions

 

This manual use the following special characters and typographical conventions:

 

Convention Meaning

 

Monospace text

 

Represents text that appears on your computer’s screen, or that could 
appear on your computer’s screen.

 

Boldface mono-
space text

 

Represents characters that you enter exactly as shown (unless the 
characters are also in 

 

italics

 

—

 

see 

 

Italics

 

, below). If you could enter the 
characters, but are not specifically instructed to, they do not appear in 
boldface.

 

Italics

 

Represent variable information. Do not enter the words themselves in the 
command. Enter the information they represent. In ordinary text, italics 
are used for titles of publications, for some terms that would otherwise be 
in quotation marks, and to show emphasis.

[ ] Square brackets indicate an optional argument you might add to a 
command. To include such an argument, type only the information inside 
the brackets. Do not type the brackets unless they appear in bold type.

| Separates command choices that are mutually exclusive.

> Points to the next level in the path to an option. The option that follows the 
angle bracket is one of the choices that appears when you select the option 
that precedes the angle bracket.

Key1-Key2 Represents a combination keystroke. To enter a combination keystroke, 
press the first key and hold it down while you press one or more other 
keys. Release all the keys at the same time. (For example, Ctrl-H means 
hold down the Control key and press the H key.)

Press Enter Means press the Enter, or Return, key or its equivalent on your computer.
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Manual set

 

The documentation set for IntragyAccess includes three manuals.

 

Setting Up IntragyAccess for Windows 95 and Windows NT

 

 (this manual). 
Provides installation and setup information for IntragyAccess in the Windows 95 
and NT environments. Also includes basic conceptual and task-oriented 
information.

 

Setting Up IntragyAccess for Macintosh

 

. Provides installation and setup 
information for IntragyAccess in the Macintosh environment. Also includes basic 
conceptual and task-oriented information.

 

Setting Up IntragyAccess for Windows 3.1 

 

. Provides installation and setup 
information for IntragyAccess in the Windows 3.1 and 3.11 environments. Also 
includes basic conceptual and task-oriented information.

 

Note:

 

Introduces important additional information.

!

 

Caution:

 

Warns that a failure to follow the recommended procedure could result in 
loss of data or damage to equipment.

 

Warning:

 

Warns that a failure to take appropriate safety precautions could result in 
physical injury.

 

Convention Meaning
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1

 

Installing IntragyAccess

 

IntragyAccess is distributed on CD-ROM. Follow the instructions in each dialog 
as you step through the installation process. You can perform a typical, compact 
or custom installation. When finished you can launch any of the IntragyAccess 
programs.

 

Performing a typical or
compact installation

 

To install IntragyAccess:

 

1

 

Exit from any Windows programs that you have running.

 

2

 

With Windows 95 or NT running, put the CD-ROM into the CD-ROM drive.

The CD-ROM’s browser window appears on your screen:
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3

 

To install IntragyAccess, select Install IntragyAccess 1.0.

The Welcome to IntragyAccess dialog appears:

 

4

 

At the Setup Type and Destination dialog, select Typical or Compact, 
depending on how much disk space you have available. (For a custom 
installation, see “Performing a custom installation” on page 1-3.) At the 
bottom of this dialog, you can either accept the suggested folder to hold the 
IntragyAccess program files or click Browse to select a different folder.

 

5

 

Follow the instructions that appear on your screen. When you are finished 
with a dialog, click Next to display the next dialog. If you want to return to 
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the previous dialog, click Back. To cancel the setup and not install 
IntragyAccess, click Cancel. The last dialog prompts you to click Finish to 
complete the installation.

 

Performing a custom installation

 

Performing a custom install is similar to performing a typical or compact install, 
except you have the option of selecting the components that best fit your personal 
needs. To perform a custom install:

To perform a custom installation, follow the procedure described in “Performing 
a typical or compact installation” on page 1-1, but at the Setup Type and 
Destination dialog:

 

1

 

Select Custom.

The Select Components dialog appears:

 

2

 

Choose which program groups you want to install by clicking in the 
checkbox to the left of the component group name.

 

3

 

To select only certain subcomponents of the FTP group or Network Utilities 
group, highlight the group and click Change.
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File Transfer components

 

If you select the File Transfer program group and click Change, the following 
Select Sub-components dialog appears:

 

2Head: File Transfer components

 

Select the desired FTP subcomponents and click Continue. If you are running 
Windows NT and you have selected FTP Server or TFTP Server, you are 
prompted for whether you would like to install these options as stand-alone 
applications or as Windows NT Services. (For information about running your 
FTP Server as Windows NT Service, see “Running your FTP Server as a 
Windows NT Service” on page 3-23, and for information about running the 
TFTP Server as a Windows NT Service, see “Running your TFTP Server as a 
Windows NT Service” on page 3-25.)

 

Terminal components

 

If you select the terminal program group the terminal components are installed. 
Since there are no sub-components for the terminal application, either you install 
the whole program or don’t install it at all.
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Network Utilities components

 

If you select the Network Utilities program group and click Change, the 
following Select Sub-components dialog appears:

Select the desired Network Utilities sub-components and click Continue.

 

Launching IntragyAccess components

 

When installation is complete, you can launch any of the IntragyAccess 
programs. Click the windows Start button and choose Programs, then 
IntragyAccess, then the program you want to launch. For information about the 
program, see the chapter describing its use.

 

Installing other software

 

IntragyAccess also includes Microsoft Internet Explorer for browsing the 
Internet, and DeskDial

To install Internet Explorer or DeskDial:
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1

 

Exit from any Windows programs that you have running.

 

2

 

With Windows 95 or NT running, put the CD-ROM into the CD-ROM drive.

The CD-ROM’s browser window appears on your screen:

 

3

 

Select the software you want to install.

 

4

 

Follow the instructions of the installer for the software you have chosen.
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2

 

Terminal emulation

 

IntragyAccess Terminal enables your computer to emulate a terminal for 
connection to a host computer. You can use Telnet to establish a remote 
connection to the host computer, or you can establish a serial connection to a 
local host. Once you have established a connection, you can save the host 
information to the Hotlist, so that you can open future sessions with a mouse 
click.

IntragyAccess Terminal provides emulation of the following types of terminals:

• DEC VT52, VT100, VT102, VT220, VT240, VT241, and VT320

• IBM 3278-2–3278-5, 3179g-2–3179g-5

• Tektronix

Terminal options enable you to specify a wide variety of preferences should you 
want to customize the way your computer emulates a terminal. IntragyAccess 
also provides a set of commands you can send to your computer or the host 
during a terminal session.

 

Establishing a Terminal connection

 

You must establish a terminal connection before you can use any features of the 
Terminal program. First, launch Terminal by clicking the Windows Start button 
and selecting IntragyAccess, then Terminal. The Connect dialog appears, with 
the Hotlist tab frontmost:
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Establishing a Telnet connection

 

If the Hotlist contains any entries, you can establish a Telnet connection by 
simply double-clicking an entry, or selecting it and clicking Connect. When the 
Terminal window appears, the remote host will prompt you for your login name 
and password. When the host accepts them, your session begins. 

But the Hotlist does not contain any entries until you put them there, one at a 
time, by establishing a connection manually, selecting Save As from the File 
menu, and entering a nickname for the session. (Of course, you probably won't 
want to create a Hotlist entry for every Telnet site you connect to.) 

 

Establishing a Telnet connection manually

 

To establish a Telnet connection manually, make sure that your screen is 
displaying the Connect dialog, then:

 

1

 

Click the Manual tab.

Manual options appear:
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2 In the Connection area, select Telnet as the connection type.

3 In the Host field, type the name or IP address of the host to connect to.

4 If you prefer to use a different model DEC or IBM terminal than the one 
shown as the default or if the server you are connecting to requires a 
particular mode of emulation, in the Emulation area, select the model you 
want from the DEC or IBM drop-down list. (Table 2-1 and Table 2-2 
describe the choices for DEC and IBM models, respectively.)

IntragyAccess will present the selected model to the host when negotiating 
the parameters for the session (provided that you select either the WILL or 
DO check box for Terminal Type in the advanced options.)

5 Either click Connect to initiate the session, or click the Manual-Advanced 
tab to select advanced options.
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Table 2-1. DEC Terminal models you can specify

Selection Specifies

VT52 VT52

VT100/VT102 VT100 or VT102

VT220/VT240/VT241 VT220, VT240, or VT241

VT320+Regis VT320

Table 2-2. IBM Terminal models and their characteristics

Model Dimensions
(columns x lines)

Graphics
Support

Extended
Attributes

IBM 3278-2 80 x 24

IBM 3278-3 80 x 32

IBM 3278-4 80 x 43

IBM 3278-5 132 x 32

IBM 3179g-2 80 x 24 √ √

IBM 3179g-3 80 x 32 √ √

IBM 3179g-4 80 x 43 √ √

IBM 3179g-5 132 x 32 √ √
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Selecting advanced options

If you select the Manual-Advanced tab in the Connection dialog, the dialog 
displays the advanced options:

In the Initial Telnet Options area, the default Port setting is 23, which is the port 
commonly used for Telnet. If the host uses a different port, enter its number in the 
Port field.

The Initial Telnet Options area also includes options for how IntragyAccess 
negotiates a session with the host. As with the Port setting, the defaults are 
usually correct. Table 2-3 explains the options.
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In the DEC Options area:

• In the Lines of Scrollback field, you can enter or select the number of lines to 
be saved in memory after they scroll past the top of the screen, so that you 
can scroll them back onto the screen if you want. A higher number requires 
more memory than a lower number.

• In the Answerback Message field, you can enter a text message to be sent 
automatically when the host requests identification from the terminal.

When you are satisfied with the specified options, click the Connect button. 
When the terminal emulator connects to the host you have specified, a terminal 
window appears. For example:

Table 2-3. Negotiation options

Option WILL DO

Binary Sender requests permission to 
begin transmitting 8 bit binary 
characters.

Sender requests that the recipient 
begin transmitting 8 bit binary 
characters.

Echo Sender requests permission to 
begin echoing data characters it 
receives over the Telnet connection.

Sender requests that the recipient 
begin echoing data characters it 
receives over the Telnet connection.

Suppress Go 
Ahead

Sender requests permission to 
begin suppressing transmission of 
the Telnet Go Ahead character 
when transmitting data characters.

Sender requests that the recipient 
start suppressing the Telnet Go 
Ahead character when transmitting 
data.

Terminal Type Sender is willing to send terminal 
type information in a later 
subnegotiation.

Sender is willing to receive terminal 
type information in a later 
subnegotiation.

End of Record Sender requests permission to 
begin transmission of the Telnet 
End-of-Record code when 
transmitting data characters.

Sender requests that the recipient 
start transmitting the Telnet End-of-
Record code when transmitting data 
characters.
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In the terminal window, the host will prompt you for a login name and password. 
When they are accepted, the session begins, and your computer acts as a terminal 
connected to the host computer.

Establishing a serial connection

You can use IntragyAccess to communicate with another computer or other 
device through a serial connection. Use the appropriate serial cable to connect a 
serial port on your computer to a serial port on the other device.

To establish a serial connection:

1 Open the Connect dialog.

2 Click the Manual tab.

Manual options appear.
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3 In the Connection area, select Serial Port as the connection type.

4 From the Port field’s drop-down menu, select the port you want to use for 
connection to the serial device.

5 From the Speed drop-down menu, select the speed at which to transfer data.

6 You can also change either of the fields in the emulation area. For details, see 
step 4 on page 1-3.

7 Either click Connect to attempt to establish the connection now, or click the 
Manual-Advanced tab to display advanced options.

When you click the Manual-Advanced tab after selecting serial port, the 
following screen appears:
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8 In the Serial options area, set the three values as specified in the 
documentation for the serial device you want to connect to.

9 To change one of the fields in the DEC options area, see page 2-6.

10 Click Connect. 

Your serial session begins

Selecting Terminal options
This section details the procedures for setting preferences for terminal sessions in 
IntragyAccess. You generally do not have to change the default settings for any of 
the preferences. But you can:

• Set general emulation options.

• Create macros.

• Reset preferences you have changed during a session.

• Map your keyboard to correspond to the keyboard of the emulation terminal 
Customize or create toolbars.

• Add entries to the Hotlist.
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Setting General emulation options

General emulation options include properties for DEC and Tektronix emulation, 
properties for IBM emulation, keyboard properties for DEC and Tektronix 
emulation, and some specifically Tektronix options.

Setting General properties for DEC and Tektronix emulation

The General tab is the first of two tabs on which you can choose DEC and 
Tektronix emulation preferences.

To set General DEC and Tektronix preferences:

1 Open a DEC or Tektronix terminal session (as described in “Establishing a 
Terminal connection” on page 2-1).

2 From the Options menu, choose Properties.

The DEC and Tektronix options appear with the General tab frontmost:

3 In the Columns/Screen area, select 80 for an 80-column display or 132 for a 
132-column display.

4 In the Lines/Screen field, enter the number of lines you want displayed on 
the screen. The default value is 24.
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5 To automatically wrap text to the next line when you reach the right margin, 
click Auto-wrap lines.

6 In the Jump Scroll area, select Always if you want to jump from one full 
screen to the next when scrolling text, select Never if you want to scroll text 
smoothly from the bottom to the top of the window, or select Host Control if 
you want the host to determine the method of scrolling text.

7 From the Normal Colors and Blink Colors drop-down menus, choose color 
values for the display of text.

8 Either click OK to save the changes and close the Properties window,

OR

Click Apply to make the changes affect the current session and leave the 
Properties window open,

OR

Click Close to close the Properties window without saving the changes.

Setting General properties for IBM emulation

The General tab is the only tab you can use to select IBM specific emulation 
preferences.

To set General IBM options:

1 Open an IBM terminal session by connecting to an IBM site.To connect to a 
site, see “Establishing a Terminal connection” on page 2-1.

2 From the Options menu, choose Properties.

The IBM options appear with the General tab frontmost:
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3 From the Character Set drop-down menu, choose a character set. The default 
is Standard U.S.

4 To prevent the emulation window from getting smaller, click Maintain 
constant window size.

5 To enable base-color mode in 3278 emulation, click Base Color.

This is applicable only on color-capable computers. You can temporarily 
change colors while the emulator is in operation by choosing Color from the 
Edit menu.

6 In the Colors area, choose color map values from the drop-down color 
palettes if you want to change the display of one or more colors.

7 Click OK to save the changes and close the Properties window,

OR

Click Apply to make the changes affect the current session and leave the 
Properties window open,

OR

Click Close to close the Properties window without saving the changes.
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Selecting Keyboard properties for DEC emulation

The Keyboard tab enables you to set keyboard preferences for DEC and 
Tektronix emulation.To set Keyboard options:

1 Open a DEC or Tektronix terminal session by connecting to a DEC or 
Tektronix site. To connect to a site, see “Establishing a Terminal connection” 
on page 2-1.

2 From the Options menu, choose Properties.

3 Click the Keyboard tab.

Keyboard options appear:

4 To use 8-bit control characters instead of 7-bit control characters, click 8 bit 
controls. 

The 8-bit mode is normally used with terminal hosts that require 
international character sets. Unless this option is enabled, each control 
sequence is sent as two 7-bit codes.This mode can be changed by the host.

5 To send non-ASCII characters from the National Replacement Character Set 
instead of the DEC Multinational Character Set, click National Keyboard 
Mode. This setting must match the host software requirements.

6 To keep the keypad in numeric mode, even if the host application tries to 
switch the keypad into application mode, select Keypad Numeric Lock.
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7 To use the ISO 8859/1 international character set, click ISO 8859/1 
Preferred. ISO 8859/1 handles international characters, such as diacritical 
marks, differently than does the DEC Multinational Character Set. This 
setting must match the host software requirements.

8 To intercept the characters specified in the Interrupt and Abort Output fields, 
select “Map characters to telnet controls”.

The special Telnet control codes are sent in place of the intercepted 
characters. Also, the Interrupt and Abort Output fields become active.

If you selected “Map characters to telnet controls,” you can specify the 
values for the Interrupt and Abort Output fields The defaults are Control-C 
(^C) and Control-O (^O).

During a terminal session pressing the key combination specified in the 
Interrupt field is the same as choosing “Interrupt Process ” from the Terminal 
menu, and pressing the key combination specified in the Abort Output field 
is the same as choosing Send “Abort Output” from the Terminal menu.

9 From the pop-up menus at the bottom of the panel, you can choose graphic 
left (GL) and graphic right (GR) character sets.

GL and GR (graphic left and graphic right) define alternate character sets 
that can be used within other character sets for special characters.

Generally, you should not need to reconfigure these settings. If you are using 
software that requires the GL and GR sets to be configured, see the 
documentation that came with the software.

The default setting for GL is U.S. ASCII (in the G0 pop-up menu). However, 
if you are working in a 7-bit environment, set G0 to GL and National 
Replacement Character Set for the language you are using (for example, 
Norwegian). The default setting for GR is DEC Multinational (in the G2 
pop-up menu).

Setting Tektronix options

To set Tektronix options:

1 Open a DEC or Tektronix terminal session by connecting to a DEC or 
Tektronix site.

2 From the Options menu, choose Properties.

3 Click the Tektronix tab.

Tektronix options appear:
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4 In the Options area, select one of the following PAGE Command options:

To clear the open window and display the graphic when a PAGE and <ESC> 
<F1-7> is received from the server, click Clears Window.

To create a new window before displaying the graphic when a PAGE and 
<ESC> <F1-7> is received from the server, click Creates new window.

5 In the GIN Termination Character field, specify a character for 
IntragyAccess to send as the end of a GIN (Graphic INput) sequence.

The character is used to define a coordinate location.

6 In the Colors area, choose values from the drop-down color palettes to 
change the display of one or more colors.

7 Click OK to save the changes and close the Properties window,

OR

Click Apply to make the changes affect the current session and leave the 
Properties window open,

OR

Click Close to close the Properties window without saving the changes.
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Creating macros for Terminal sessions

A macro is a series of keystrokes and/or commands that have been recorded and 
assigned a key combination. When you enter the key combination, the macro is 
executed. Macros can store up to 255 characters. Table 2-4 shows the key 
combinations you can use as building blocks for macros.

You can use the Macros tab to create up to twenty macros for each session. The 
macros are stored in your IntragyAccess Settings file, along with other session 
information, on a per-session basis. When you switch between session windows, 
the macros associated with that window become active. When you save session 
information to the Hotlist, you also save the macros.

Table 2-4. Special key sequences for macros

Key combination Result

\nnn

(where nnn is a 3-digit 
octal number)

Sends that octal value.

For example, \011 sends a tab
(octal 011=decimal 9=^I=tab).

\i Sends your IP address.

For example, 123.4.54.321.

\# Sends the number of lines currently displayed on 
your terminal screen.

\t Sends a tab character.

\n Sends a CRLF (carriage return + line feed) 
character.

\m Sends a CR character (^M).

\j Sends a LF character (^J).

\\ Sends a \ character.
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To create a new macro:

1 Open a Terminal session (as described in “Establishing a Terminal 
connection” on page 2-1).

2 From the Options menu, choose Properties.

3 Click the Macros tab.

Macros definition fields appear:

4 In one of the fields, enter the keystroke sequence that you want the macro to 
execute.

The keystrokes entered in a field will be sent when the number to the left of 
the field is pressed in combination with the Alt key.

5 Click OK to save the changes and close the Properties window, or click 
Close to close the Properties window without saving the changes.

Resetting Terminal values

If, during a terminal session, you change some of the preferences for your 
session, you can reset the values to what they were at the beginning of the 
session.

To reset your preferences:
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1 Make sure that the terminal session window you want to reset variables for is 
frontmost.

2 From the Terminal menu, choose Reset Terminal.

The variables for the current terminal session are reset.

Note: Although the screen is cleared, this command does not clear the 
scroll back buffer.

Keyboard mapping

A keyboard map enables your keyboard to mimic keys that exist on other kinds of 
keyboards When you save session information to the Hotlist, you automatically 
save any keyboard map you have created for the session. If you later edit the map, 
you must re-save the session to save the changes you have made.

To create or edit a keyboard map:

1 Open a Terminal session as described in “Establishing a Terminal 
connection” on page 2-1.

2 From the Options menu, choose Keyboard Maps.

The Keyboard Map window appears:

3 Drag a special key from the key palette display at the bottom of the window 
to the key on the keyboard you want to map it to.

The keyboard key changes to reflect the special key you dropped on it.

4 To remove a key assignment, drag the key from the keyboard into the Trash. 
To return all of the keys to their default values, click Default.
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5 Close the map dialog by clicking OK when you are finished mapping or 
remapping keys.

Creating and using toolbars in terminal sessions

A toolbar displays a group of keys on your screen. Each key in the display 
represents a function key or other key that exits on the keyboard of the terminal 
you are emulating, but not necessarily on your keyboard. IntragyAccess provides 
predefined toolbars for DEC and IBM emulation. You can also create your own 
DEC or IBM toolbars, or customize the default toolbars.

Accessing toolbars

To display a toolbar:

1 Open a Terminal session as described in “Establishing a Terminal 
connection” on page 2-1.

2 From the Options menu, choose Properties.

3 Click the Toolbars tab.

Toolbars options appear:

4 In the Toolbars list select the toolbar(s) you want to display.
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The toolbar(s) you select appear on the screen. For example, the following 

toolbar appears if you select All DEC Function Keys:

You can change the view of your toolbar by dragging the borders of the toolbar. 

Here, for example, are some of the ways you can display the All DEC Function 

Keys toolbar:

5 Click OK to save the changes and close the Properties window,

OR

Click Apply to make the changes affect the current session and leave the 

Properties window open,

OR

Click Close to close the Properties window without saving the changes.

Creating a new toolbar

To create your own custom toolbar for a DEC or IBM emulation session:

1 Open a Terminal session as described in “Establishing a Terminal 

connection” on page 2-1.

2 From the Options menu, choose Properties.

3 Click the Toolbars tab.

Toolbars options appear:
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4 Click New.

A dialog appears, prompting you to enter a name for the new toolbar.

5 In the field provided, type a name for the new toolbar.

6 Click OK. 

A new palette is created, and appears on your screen. When you first create 
the toolbar, the squares are empty. The new toolbar’s name appears in the list 
in the Toolbars tab.

7 Proceed to customizing your new toolbar.

Customizing an existing toolbar

You can change the default toolbars, or any of the toolbars you have created, by 
adding or removing buttons. First display the toolbar by selecting it from the list 
on the Toolbars tab in the Properties dialog.
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Adding buttons to a toolbar

To add buttons to a toolbar:

1 In the Properties dialog, click the Customize Toolbars tab.

Customize Toolbars options appear:

2 In the Categories area, select the category of buttons containing the source 
keys you want to use.

3 Drag the buttons from the Buttons area onto the toolbar.

For example, you could modify the All DEC Function Keys toolbar by 
dragging a New Terminal button from the Functions category:

4 Click OK to save the changes and close the Properties window,

OR

New Terminal 
button
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Click Apply to make the changes affect the current session and leave the 
Properties window open,

OR

Click Close to close the Properties window without saving the changes.

Removing buttons from a toolbar

You can remove a key from any palette that you created by dragging it out of the 
toolbar while the Customize Toolbar tab is showing. You can replace a key by 
dragging another key on top of it. Following is a DEC toolbar with many of the 
keys dragged out of it:

Renaming a custom toolbar

You can change the name of a custom toolbar at any time. The default toolbars 
cannot be renamed.

To rename a toolbar:

1 Open a Terminal session as described in “Establishing a Terminal 
connection” on page 2-1.

2 From the Options menu, choose Properties.

3 Click the Toolbars tab.

Toolbars options appear:



Terminal emulation
Selecting Terminal options

2-24 Setting Up IntragyAccess for Windows 95 and Windows NT

4 From the toolbars list, select the toolbar to rename.

If you are able to rename the toolbar, the name appears in the Toolbar name 
field below the toolbars list.

5 In the field provided, type the new name.

6 Click OK. 

The toolbar is renamed, and the name is changed in the toolbars list.

Removing a custom toolbar

You can delete any toolbar you create. Default toolbars cannot be removed.

To remove a toolbar:

1 Open a Terminal session as described in “Establishing a Terminal 
connection” on page 2-1.

2 From the Options menu, choose Properties.

3 Click the Toolbars tab.

Toolbars options appear as shown in “Renaming a custom toolbar” on page 
2-23.

Delete is enabled if the palette you selected is able to be deleted.

4 From the Toolbars list, select the toolbar you want to delete.

toolbar to be 
renamed

where you 
change the name
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5 Click Delete.

The toolbar is deleted, and its name is removed from the toolbars list.

Saving a Terminal session as a Hotlist item

Terminal Hotlist entries make short work of connecting to remote hosts. You 
simply double-click an icon to establish a connection to a frequently accessed 
host. A Terminal Hotlist entry contains all of the options and properties 
information pertaining to a terminal session with a particular host. You can create 
new Hotlist entries and edit existing ones.

Creating a Terminal Hotlist item

You can create a hotlist entry for a session after you have established a 
connection.

To create a Terminal Hotlist entry:

1 Open a Terminal session as described in “Establishing a Terminal 
connection” on page 2-1.

2 Define all options you want stored in the Hotlist entry.

3 From the File menu, choose Save Session As.

The Save Session dialog appears:

4 In the Name field, type a name for this Terminal Hotlist entry.
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5 If you want to save the item a new Hotlist folder, click New Folder. 
Otherwise, skip to Step 9.

The New Folder dialog appears:

6 In the field provided, type a name for the new folder.

7 Click OK.

The new folder appears in the folders list.

8 Select the folder to save the terminal session.

9 Click OK.

The session is saved as a Hotlist item.

Editing Terminal Hotlist entries

If you need to change any information, you can edit a terminal hotlist entry.

To edit a previously saved Hotlist entry:

1 Use the entry to establish a connection.

2 Edit the preferences as necessary.

3 From the File menu, choose Save Session.

The changes you have made are saved to the hotlist.

For more information
For more information about hotlist entries, see Chapter 4, “Using and 
maintaining Hotlists.”

Commands in Terminal sessions
IntragyAccess Terminal includes many short cuts to commands commonly used 
during a session. You can send commands to the host, and other commands to 
capture data, control your display, and print session data.
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Sending commands to the remote host

While in a terminal emulation session, you can send commands to the remote 
system you are connected to. Simply make sure the Terminal window for the 
connection you want to send a commands to is frontmost, then choose the 
command from the Terminal menu or the Send menu.

The Terminal menu includes the following commands:

Following are the commands available in the Send menu.

Command Description

Backspace sends DEL Causes the Backspace key on your keyboard to 
send the Delete character to the terminal instead 
of the Backspace character. A checkmark appears 
to the left of this menu item when it is enabled.

Local Echo Causes IntragyAccess to immediately display 
characters that you type, instead of waiting for the 
host to send a copy of the character back to your 
screen. A checkmark appears to the left of this 
menu item when it is enabled.

Clear Screen Saves 
Lines

Saves a page of text to the scroll back buffer when 
the host issues a clear screen command. A 
checkmark appears to the left of this menu item 
when it is enabled.
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Capturing Session Data

To save data from the current DEC session to a file on your computer:

1 From the File menu, choose Capture.

A standard file dialog appears.

2 Navigate the dialog to select a location to which to save the file.

3 In the field provided, type a name for the file.

4 Click Save.

A checkmark appears to the left of the Capture option to signify that it is 
enabled, and data is saved to that file until you disable the option or end the 
connection.

Command Description

Send FTP Command Sends the text ftp followed by the IP address of 
your computer. This command is useful when you 
want to transfer files back to your computer via 
FTP during a Telnet session.

Send IP Number Sends the IP address of your computer.

Send “Are You There?” Checks for the presence of the host computer.

Send “Abort Output” Stops the host from sending data to the terminal 
display.

Send “Interrupt Process” Interrupts the program that is currently running.

Send “Erase Character” Removes the last character you typed.

Send “Erase Line” Erases the last line you typed before you pressed 
the Return key.

Send Break Sends the standard break command on the 
communications line.
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To disable the capture session data option:

1 Make sure the terminal session window for which you want to disable 
session capturing is frontmost.

2 From the File menu, choose Capture.

The checkmark is no longer displayed to the left of the menu option, and 
data is no longer saved to a file.

Selecting Columns
You have the ability in a terminal session to select columns of text instead of 
lines of text.To select a column of text, press Ctrl, and drag the mouse to 
select the column you want. The column is selected.

Copying Tables

You can copy a table from a terminal window and paste it into a spreadsheet or 
database application without losing the column formatting.

To copy a table:

1 Select the table, or part of the table.

2 From the Edit menu, choose Copy.

The data is copied to your Clipboard.

3 Open the spreadsheet or database application into which to copy the table.

4 From the Edit menu, choose Paste.

The data is inserted into its correct columns in the spreadsheet or database 
application.

Zooming

In Tektronix emulation mode, you can enlarge a portion of a graphic if you want 
to see it in more detail. Just press the left mouse button, drag a rectangle around 
the portion you want to enlarge, and release the mouse button. The area you drew 
the rectangle around is enlarged in the emulation window. To go back to the 
original display, double-click the zoomed portion of the graphic.
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Printing

You can print a terminal session window if your computer is connected to a 
printer. Proceed as follows:

1 Select the information to print.

2 From the File menu, choose Print.

A standard Print dialog appears.

3 Complete the necessary parts of the dialog, and click Print.
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3File transfer and sharing

IntragyAccess enables you to use the File Transfer Protocol (FTP) to transfer 
files to and from other computers. You can also set up your computer as an FTP 
server, or as a server that uses the simpler Trivial File Transfer Protocol (TFTP). 
You can also use Network File Sharing (NFS) to transfer files.

Using FTP to transfer files
To use FTP to transfer files, you must first establish an FTP connection (which 
you can save to the Hotlist if you wish). Next, you use the FTP window to specify 
options. You can then download or upload files. You can customize the FTP 
window.

Establishing an FTP connection
The most important part of an FTP transaction is the connection. Without the 
connection, other tasks are impossible. To establish an FTP connection:

1 Launch the FTP Client by clicking the Start button and selecting Programs, 
IntragyAccess, and then FTP Client.

The FTP Connect dialog appears:
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2 If you have previously defined Hotlist entries, you can select an entry and 
skip to step 15. To establish a connection manually, click the Manual 
Connect tab.

Manual Connect options appear:

3 In the Name field, enter a descriptive name for this FTP session.

4 In the Host field, enter a fully- or partially-qualified host name or IP address.

5 Many sites allow visitors to log on anonymously. Typically, they request 
your email address as the password. If you select the “Anonymous 
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connection” check box, IntragyAccess supplies values for the Username and 
Password fields, and you can skip steps 6 and 7.

6 In the Username field, enter a username for IntragyAccess to present to the 
host you want to make a connection to.

7 In the Password field, enter your password.

You can leave the Username and Password fields blank if you prefer to be 
prompted for this information when the FTP connection is made. 

If you choose to make your FTP connection now, go to Step 14. To configure 
additional options for this connection, proceed with Step 7.

8 To specify further connection options, click the Manual Connect - Advanced 
tab.

The Manual Connect - Advanced tab appears:

9 From the Host Type pop-up menu, select a Host type for the FTP Server you 
are connecting to, or choose Automatic to let IntragyAccess select a host 
type.

10 In the Local Folder field, type a path to the folder to which you want to save 

your retrieved files. Or click ( ). To navigate a path to the desired 

directory.

11 In the Remote folder field, type a path to the folder you want to connect to on 
the remote machine.
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You can also leave the Local Folder and Remote Folder fields empty if you 
would rather choose the folders after the connection has been made.

12 In the Connection Retries field, type the number of times you want 
IntragyAccess to attempt to connect to the server.

13 In the Retry Delay field, type in the number of seconds you want 
IntragyAccess to wait between connection attempts.

14 If you know the character set of the host you are connecting to, select the 
correct setting from the “Host text encoding” drop-down menu.

15 Click Connect.

You are connected to the specified FTP site and the FTP window appears.

Saving an FTP session as a Hotlist item
After you establish a connection by entering the necessary information, you can 
save the information as a Hotlist entry. FTP Hotlist entries make short work of 
connecting to an FTP server. You simply double-click an icon.

Creating an FTP Hotlist item

You can create a Hotlist entry for an FTP session. This can be done only after you 
have already established an FTP connection.

To create an FTP Hotlist entry:

1 Open an FTP session (as described in “Establishing an FTP connection” on 
page 3-1). Be sure to define all the options you want stored in the Hotlist 
entry.

2 From the File menu, choose Save Session As.

The Save Session dialog appears:
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3 In the Name field, type a name for this FTP Hotlist entry.

4 If you want to save the item a new Hotlist folder, click New Folder and enter 
a name for the new folder.

5 Select the folder in which to save the FTP session.

6 Click OK.

The session is saved as a Hotlist item.

Setting FTP Client options
Once you have configured you computer for an Internet connection you can use 
the FTP Client in IntragyAccess. After you launch the FTP Client, choose 
Options from the Options menu. The Options panel appears, with the General 
Options tab frontmost:
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The Options panel includes tabs for setting options for:

• General Options

• Confirmations

• Firewall Support

• Extension Mapper

Setting General Options

The General Options tab is the first of four tabs you can use to select your FTP 
preferences. With the General Options tab selected, select options to apply to 
FTP sessions:

• Select Verbose status messages to show more detailed messages in the 
command window at the bottom of the FTP window.

• Select Prompt for destination filenames to bring up a dialog prompting you 
for a filename each time you transfer a file.

• Select Transfers are mutithreaded to transfer files in multithread mode.

When finished, click OK to save the changes and close the Options window, or 
Apply to make the changes affect the current session and leave the Options 
window open or click Cancel to close the Options window without saving the 
changes.
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Setting Confirmation options

In the Confirmations tab, you can choose which operations display a 
confirmation dialog before performing the task. Click the Confirmations tab, 
Confirmation options appear:

In the Confirm when area, select the operations for showing a confirmation 
dialog.

When finished, click OK to save the changes and close the Options window, or 
click Apply to have the changes affect the current session and leave the Options 
window open or click Cancel to close the Options window without saving the 
changes.

Setting Firewall Support

Sometimes you will ant to make a connection to an FTP server you have access 
to that resides behind a Firewall. If you click the Firewall Support tab, Firewall 
Support options appear:
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1 Select Enable Firewall Support to turn on firewall support.

2 In the Firewall Host Information area, enter information about the host with 
the Firewall you want to access:

– In the Host Address field, enter the address of the host.

– In the Port field, enter the port for the specified host address or accept 
the default (21 is a widely used port for FTP).

– In the Username field, enter your username.

– In the Password field, enter your password.

3 In the Firewall Type area, select the firewall type for the host:

– Select SITE Host to log into the firewall and then establish the 
connection to the destination FTP server using the SITE host command.

– Select Proxy OPEN to establish the FTP session with the destination 
FTP server using the OPEN <host> command.

– Select USER after Log On to establish your connection to the 
destination FTP server using the USER userid@host command.

– To establish the connection to the destination FTP server using the 
USER userid@host command, click USER (user@host).
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4 In the Firewall use not required for these domains area, enter the domain 
names that do not require firewall support. Separate multiple domain names 
with commas.

5 When finished, click OK to save the changes and close the Options window, 
or click Apply to have the changes affect the current session and leave the 
Options window open or click Cancel to close the Options window without 
saving the changes.

Mapping Extensions

Extensions mapping makes a connection between certain file extensions and 
automode FTP transfers. IntragyAccess includes several extensions mapped to 
either binary or text modes. You can add new extension mappings, and edit or 
remove existing ones. If you click the Mapping Extensions tab in the Options 
window, Extension Mapper options appear:

To add an extension mapping:

1 Click Add.

The Extension Information dialog appears:
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2 Enter the extension you want to map.

3 Choose a file type (either Binary File or Text File) from the File Type drop-
down menu.

4 Click OK.

The extension mapping is added to the list.

To edit an extension map:

1 Select the extension from the Extension Mappings area.

2 Click Edit.

The Extension Information dialog appears:

3 Edit the information as necessary.

4 Click OK.

The entries properties are changed.

To remove an entry, select the entry from the extension mappings list and click 
Remove.

When finished, click OK to save the changes and close the Options window, or 
click Apply to have the changes affect the current session and leave the Options 
window open. Or click Cancel, to close the Options window without saving the 
changes.
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Using the FTP window
The FTP window contains many features to help you optimize your time and 
increase productivity while using IntragyAccess FTP. This is an example of the 
main FTP window:

This figure details some of the FTP window’s main features:
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Shortcuts to commonly used commands

The toolbar contains shortcuts to many of the most commonly used FTP 
commands.When you place the mouse cursor on one of the shortcut buttons, a 
small pop-up window describes the function that the button provides.

Viewing higher directories of the local and remote folders

Click on the local folder title or the remote folder title to see the hierarchy of the 
directories above it. If you see no higher directories, you have reached the root 
directory for that location or the root directory you have access to through this 
mountpoint. (A mountpoint is a location to which you are granted access. For 
more information about mountpoints, see “Creating mountpoints for your FTP 
server” on page 3-19.)

Checking the status of the FTP connection

To monitor the status of the FTP connection, just check the status bar at the 
bottom of the window. It displays messages about what is happening with the 
connection.

Toolbar

Local 
folder title

Local 
folder 
listing

FTP log tab

Status bar

Remote 
folder title

Remote 
folder 
listing

Command 
line area
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Transferring a file
Transferring files is the reason for using FTP. IntragyAccess FTP makes it easy 
for you to download and upload files or change transfer modes.

Downloading a file

When you download a file, you transfer (copy) it from a remote host computer 
(an FTP server) to your local computer (the FTP client). To download a file:

1 Establish an FTP session (as described in “Establishing an FTP connection” 
on page 3-1).

2 Select one or more files in the remote directory.

To select multiple continuous files, press Shift while highlighting the first 
and last files you want to select.

To select multiple discontinuous files, press Control while highlighting each 
file.

3 Drag the selected file(s) to a directory on the local computer.

4 Drop the file(s).

The selected file(s) is (are) copied into the target directory.

Uploading a file

When you upload a file, you transfer (copy) it from your local computer (an FTP 
client) to a remote host computer (the FTP server). To upload a file:

1 Establish an FTP session (as described in “Establishing an FTP connection” 
on page 3-1).

2 From a local directory in the FTP window, select the file or files to upload to 
the remote host.

To select multiple continuous files, press Shift while highlighting the first 
and last files you want to select.

To select multiple discontinuous files, press Control while highlighting each 
file.

3 Drag the selected file(s) to the directory on the remote computer.

4 Drop the file(s).

The selected file(s) is (are) copied into the specified directory.
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Changing file transfer modes

Text files should be transferred in ASCII mode. Other files should be transferred 
in binary mode. To change modes, click one of the following icons on the icon 
bar:

• Binary mode ( ) selects Binary mode.

• ASCII mode ( ) selects ASCII (text) mode.

• Auto mode ( ) automatically selects the mode based on the filename. (If 
Automode displays the file type as unknown or as a type you know to be 
incorrect, select the correct type by clicking one of the other icons.)

Opening a file

You can open a file and view its contents in the FTP window before you 
download the file. Just select the file and choose View from the Commands menu.

Customizing the FTP Window

IntragyAccess allows you to customize the FTP window. Functional views and 
toolbars with commonly used tasks are set as defaults. You can change the 
display of the local window, create and customize toolbars, remove toolbars, and 
change the function of the command window to display log information.

Changing the display of the local window

To move the local window, place the mouse cursor in the bar at the top of the 
window and drag it to any location in the FTP window. Or, after you have 
selected the local window by clicking in the bar, you can remove the window by 
clicking the close box. To redisplay the local window, select Local window from 
the View menu.

Creating and customizing toolbars

To create a new toolbar:

1 Select Toolbars from the View menu.

The Customize toolbar window appears:
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2 Click New.

The dialog for naming the toolbar appears.

3 Give the toolbar a descriptive name.

4 Click OK.

An empty toolbar appears in the main FTP Window.

5 Click the Commands tab in the Customize toolbar dialog.

The Commands tab moves to the front. The categories on the left of the 
window describe which buttons fall under each category. If you click on any 
button, the buttons description appears below.



File transfer and sharing
Using FTP to transfer files

3-16 Setting Up IntragyAccess for Windows 95 and Windows NT

6 Drag and drop each button you want to add to your newly created toolbar to 
the empty toolbar in the FTP window.

To remove a button from your toolbar drag the button from the toolbar to the 
button area of the Commands tab.

Customizing an existing toolbar is similar to creating a new toolbar. Instead of 
clicking New, select the toolbar from the toolbar list and click OK.

Changing the display of the toolbar

Each toolbar has a title bar which enables you to change the toolbars location. 
For example:

Click and hold the titlebar to drag the toolbar to where you want to place it in the 
FTP window. If you want the toolbar to float on top of windows inside the FTP 
window double click the title bar

Toolbar 
titlebar



File transfer and sharing
Setting up an FTP server

Setting Up IntragyAccess for Windows 95 and Windows NT 3-17

Deleting a toolbar

You can delete any toolbar except the default toolbar.

To delete a toolbar:

1 Select toolbars from the View menu.

2 Click the Toolbars tab.

3 Select the toolbar you want to delete.

4 Click Delete.

The toolbar is removed from the list.

Changing between command line mode and FTP log mode

At the bottom of the FTP window (unless you move it) is the Command window. 
If you select the Command Line button, you can enter FTP commands in the 
Command window, and IntragyAccess sends them to the server. If you select the 
Log button, the window displays all the messages exchanged by IntragyAccess 
and the FTP server.

You can change the location of the Command window by dragging its title bar. 

If you want the Command window to float on top of windows inside the FTP 
window double click the title bar. If you close the window (by clicking the button 
in its top left corner), you reopen it by selecting “Command window” from the 
View menu.

Setting up an FTP server
IntragyAccess enables you to set up your computer as an FTP server, so that you 
can permit specified remote users to connect to your computer and access files 
for which you grant permission. To access the server functions, click the 
(Windows) Start button and choose IntragyAccess, then FTP Server. The FTP 
Server dialog appears with the General tab foremost:
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Setting general FTP server options

To set general FTP server options:

1 On the General tab of the FTP Server dialog, either accept the default value 
in the TCP Port field or enter a new value. (The default, 21, is the well-
known port for FTP. If you enter a different value, be sure to inform the 
remote users, so that they can connect successfully).

2 In the Connect Timeout (seconds) field, type in the number of seconds you 
want to pass before an idle remote connection is timed out.

3 In the Maximum Connections field, type the maximum number of people 
you want allowed to be connected to your computer at one time.

4 In the Maximum Anonymous Connections field, type the maximum number 
of anonymous users that can be logged on to your computer at one time.

5 In the Background FTP Server Mode area, choose a security level.

To permit file transfers by users who have been given accounts on your 
computer (as set in the Users configuration panel), click Secure. (For 
information about the Users configuration panel, see “Configuring users for 
your server” on page 3-21.)

To permit file transfers by users with accounts on your computer, and by 
users who enter anonymous as their user names when they connect to your 
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computer, click Secure and Anonymous. Typically, anonymous FTP users 
are not permitted to transmit files to your computer or to delete files from 
your computer. They are able only to copy files. This can be useful if you 
want to allow the general public to download certain files from your 
computer without having to obtain prior authorization.

6 To enable your FTP server, click Start Server.

7 To save the changes, either click Apply or close the window.

Your FTP Server configuration is saved.

Creating mountpoints for your FTP server

The Mountpoints tab allows you to set up permissions for particular directories 
on your computer. A mountpoint is a configuration containing permissions 
information and a link to a folder through which a user can access other nested 
files and folders.

To create a new mountpoint for users:

1 In the FTP Server dialog, click the Mountpoints tab.

Mountpoints options appear:

2 Click Add.

The Add Mountpoint dialog appears:
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3 In the Alias field, type a name for your mountpoint. You might want to name 
the mountpoint after the folder or user, or make up a name that you’ll 
remember.

4 In the Path area, type a specific path to the folder you want to act as a 

mountpoint, or click ( ) to trace a path to the desired directory.

5 Click OK.

You are returned to the Mountpoints options panel.

6 Click OK.

Your new mountpoint is saved. You cannot access the mountpoint until you 
grant them permission, as described in “Creating a user account” on page 3-
21.

Editing mountpoints

To edit a mountpoint you have created:

1 Open the Mountpoints options dialog.

2 Select the mountpoint you want to edit.

3 Click Edit.

The Edit Mountpoint dialog appears:

4 Edit the information as necessary.

5 Click OK.

The mountpoint information is changed.
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Deleting mountpoints

To remove a mountpoint:

1 Open the Mountpoints options dialog.

2 Select the mountpoint you want to delete.

3 Click Delete.

The mountpoint is removed your mountpoints list.

Configuring users for your server

To permit FTP remote users to connect to your FTP server, you create accounts 
for them. You can edit or delete an existing account.

Creating a user account

To create a new user account:

1 In the FTP Server window, click the Users tab.

Users options appear:

2 Click Add.

The Edit User dialog appears:
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3 In the User ID field, enter the user name for the new account.

This is the user ID an FTP client uses to log on to your FTP server.

4 In the Full Name field, you can type the real name of the user.

5 In the Password field, type a password for this User.

6 In the Password confirmation field, type the same Password to confirm the 
original.

7 In the accessible Mountpoints area, check the mountpoint folders you want 
this user to have access to.

8 From the Mountpoint Permissions list, select options for this user.

– To allow the user to view lists of all the files in the selected folders, click 
List.

– To allow the user to alter existing files and create new files within the 
selected folders, click Write.

– To allow the user to create new folders within the selected folders, click 
Create Directory.

– To allow the user only to view the contents of files, click Read.

– To allow the user to remove files from the selected folders, click Delete. 

9 Click OK.
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The new configuration appears in the scrolling list at the top of the Users 
configuration panel. The Users options dialog reappears.

10 Click OK.

Editing user accounts

To edit a user account:

1 In the FTP server dialog, click the Users tab.

Users options appear.

2 Select the user profile you want to edit.

3 Click Edit.

The Edit User dialog appears.

4 Edit the information as necessary.

5 Click OK.

The user profile is changed to reflect the changes you have made.

Deleting user accounts

To remove a user account:

1 In the FTP server dialog, click the Users tab.

Users options appear.

2 Select the user you want to remove.

3 Click Delete.

The user is removed from your list of users.

Running your FTP Server as a Windows NT Service

In Windows NT, you can install and use the FTP server as an NT Service in the 
Control Panels. To do so, you must have installed FTP Server as an NT Service. 
(For information about installing FTP Server as an NT Service, see “File Transfer 
components” on page 1-4.)

To launch the FTP Server Windows NT Service and set its permissions:

1 Double-click the My Computer icon on the desktop.

2 In the My Computer program group, double click the Control Panels icon.
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The Control Panels window appears, similar to:

3 Double-click the IntragyAccess FTP Server icon.

4 Proceed with setting permissions the same as in “Setting up an FTP server” 
on page 3-17.

Setting up a TFTP server
A TFTP (Trivial File Transfer Protocol) server is a more simple FTP server with 
no directory or password capacity.

To launch the TFTP Server and set its permissions: 

1 Click the (Windows) Start button and choose Programs from the Start menu, 
then choose IntragyAccess, and then choose TFTP Server.

The TFTP Server dialog opens:
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2 In the Sharing field, type a path to the single directory you want to make 

available via TFTP, or click ( ) to trace a path to the desired directory.

3 In the Access Permissions area, click the permissions you want to allow 
users to perform on any of the files in the shared directory.

4 Click Apply to apply the changes you have just made

5 Click Quit when you want to stop the TFTP Server.

Running your TFTP Server as a Windows NT Service
In Windows NT, you can install and use the TFTP server as an NT Service in the 
Control Panel. To do so, you must have installed TFTP Server as an NT Service. 
(For information about installing TFTP Server as an NT Service, see“File 
Transfer components” on page 1-4.)

To launch the TFTP Server NT Service and set its permissions:

1 Double-click the My Computer icon on the desktop.

2 In the My Computer program group, double click the Control Panels icon.

The Control Panels window appears, similar to:
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3 Double-click the IntragyAccess TFTP Server icon.

4 Proceed with setting permissions the same as steps 2 and 3 of the regular 
TFTP Server above.

Network file sharing
Your IntragyAccess NFS client for Windows enables you to use the Network File 
System (NFS) for transparent, shared access to files on a network.

Functionally, NFS is composed of two parts: a client and a server. Your NFS 
client enables your computer to access, manipulate, and print files on NFS 
servers as if the files were stored on your computer. The NFS client is accessible 
through Network Neighborhood or Windows Explorer in Windows 95 and NT. 

A client is a program or computer that requests services from a network or server. 
The client provides the user interface and performs some, or most, of the 
application processing.

A server is a computer or program designed to provide a service to a network 
used by multiple users. A server communicates with a client to handle the client’s 
input and output needs.
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You can also use your NFS client to print to network printers. To do so, you must 
enable your NFS client and then redirect a printer port to the network printer.

Setting up the NFS Client

Before you can use your NFS client, you must enable it and enter the proper 
authentication information.

Accessing the NFS Client configuration wizard

You can access the NFS Client configuration wizard by launching IntragyAccess 
NFS Config.

To access the NFS Client configuration wizard:

1 Click the (Windows) Start button and choose Programs, then IntragyAccess, 
then choose NFS Config.

The NFS configuration wizard appears:

Enabling your NFS Client and setting default user information

To make the NFS Client easier to use, you can set default user information. The 
information you provide is a shortcut, and entering information is not required to 
use your NFS client.

To enable your NFS Client and set authentication information:
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1 Open the NFS Client configuration wizard.

2 To actually start your NFS client, click the Enable checkbox.

Your NFS Client is available for use and can now be accessed through your 
Windows software.

To disable your NFS Client, click the Enable checkbox again. When the 
checkbox is empty, your NFS client is disabled.

3 To print via NFS, click the Enable Printing checkbox.

4 Click Next.

Default User Information options appear:

5 In the Username field, type the name your System Administrator has 
assigned to you for the NFS servers you plan to connect to.

6 In the Password field, type the password associated with your user name for 
the NFS servers you plan to connect to.

7 Click Next.

Authentication options appear.

Selecting Authentication options

NFS Servers can use different protocols to authenticate user information. There 
are two protocols you may use to connect to NFS Servers, depending on which 
one the Server is using. Network Information Service (NIS) is a user 
authentication and information service developed by Sun Microsystems. An NIS 
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domain name is a unique name, assigned arbitrarily by a network administrator, 
that provides an administrative grouping of computers. The second protocol is 
Personal Computer NFS Daemon (PCNFSD) which is a simple user 
authentication service for non-UNIX clients. There are currently two versions, 
PCNFSD version 1 and PCNFSD version 2.

To set authentication options:

1 Follow the NFS configuration wizard until the Authentication options 
appear:

2 If the server you are connecting to uses NIS as its authentication method, 
click Use NIS Authentication, and in the NIS Domain field, type the domain 
name that your System Administrator has designated for NIS authentication 
on your network.

3 If the server you are connecting to uses PCNFSD as its authentication 
method, make sure that Use NIS Authentication is not selected, and in the 
PCNFSD Authenticator field, type the host name of the computer on your 
network that is responsible for all authentication.

4 Click Next.

Setting up servers in the servers list

If you want to use Network Neighborhood to browse for an NFS volume, you 
must first add servers to the Servers List in the NFS Client configuration wizard.

To add NFS servers to the Servers List:
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1 Follow the NFS Client configuration wizard until the Servers List 
information appears:

2 To browse dynamically and show all NFS Servers available your network 
choose when you want IntragyAccess to look for servers on your network in 
the Browse area.

Servers found on your network appear in the Currently Added Servers list.

3 To add a specific server, type the name or IP address of the NFS server you 
want to mount in the Server to Add field. If you do not know the name or IP 
address, contact your System Administrator.

4 Click Add Server.

The IP address appears in the Server Addresses scrolling list.

Note: If the NFS Client cannot resolve the name or IP address of the NFS 
Server you type in the dialog, a Winsock error is returned. Check the name of the 
server and try again.

5 Click Next.

Removing servers from the servers list

To remove a server from the Server Addresses list:

1 From the Currently Added Servers list, select the IP address of the server you 
want to remove.

2 Click the Delete Server button.
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The server is removed from the servers list.

3 Click Next.

Setting default connection options for NFS

There are certain options you can set for logging into NFS servers using default 
login procedures.

To set default options for connecting to an NFS server:

1 Follow the the NFS configuration wizard through the Servers List dialog. 
After clicking Next at the end of this dialog, you have the option of changing 
the default connection options. Click the Defaults button.

Default options appear:

2 In the File Permissions area, define the types of access that the User (the 
owner of the file), the Group (specific users who have access to the file), and 
Others (anyone else who may encounter the file) can have to the files you put 
on the NFS volume you are mounting:

– To allow the contents of the file or directory to be viewed, select R for 
Read. No changes can be made to the contents of the file or directory 
under Read access.
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– To allow the contents of the file or directory to be changed, select W for 
Write. (The contents of the file or directory cannot be viewed unless you 
select R.)

– To allow a program to be run or a directory to be searched, select X for 
Execute.

3 In the File Access area, define which type of access you have to the files on 
the NFS volume you want to mount:

– If you have been granted access both to view and change the contents of 
files or directories on this NFS volume, click Read/Write.

– If you have been granted access only to view the contents of files or 
directories on this NFS volume, click Read Only.

4 In the File Case area, select the preference for downloading filenames.

5 In the Transport Area, enter the transport protocol for tranferring the 
files.There are two transport protocols you may choose from. The 
differences between these protocols is mainly the speed of data transfer 
using that protocol and on whether the remote server supports that protocol 
or not.

TCP (Transmission Control Protocol) is a connection-oriented protocol. 
TCP is reliable and the data sent to the remote machine are guaranteed to 
reach to the destination.

UDP (User Datagram Protocol) is a connection-less protocol. UDP is a 
datagram service without any connection being set up initially. The data sent 
through UDP may or may not reach the destination in proper order, or may 
not reach at all.

6 In the Buffer Sizes area, type 4096 in both the Read and Write fields.

The default for the Read and Write fields, 8192, is too high for many 
networks. Lowering the buffer speed helps speed up the connection.

7 In the Retransmissions area, in the Maximum field, type the maximum 
number of times you want your NFS client to resend information if the 
server does not respond to the initial request. The default value for this field 
is 3 times. The value for this field can range from 1 to 127.

In the Timeout field, type the amount of time, in seconds, that you want your 
NFS client to wait before resending information if the server does not 
respond to the initial request. The default value for this field is 2 seconds. 
The value can range from 1 to 14.
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8 In the White and Read Threading Area, type the number of read or write 
calls to be sent in parallel over the network before receiving a reply for the 
first call sent. This option is mainly used to increase the efficiency of the 
network connection. It reduces the time for which the connection just 
remains idle without any traffic on it if the reply for the first call is awaited

9 If the NFS server you are connecting to has a Network Lock Manager 
daemon that supports 3.1 file locking/sharing, click Enable 3.1 Locking/
Sharing.

Contact your System Administrator if you need information about the file 
locking/sharing support for the NFS server you are connecting to.

10 Click OK to save these as the default settings.

11 Click Next and to finish the configuration changes, click Finish.

Connecting to an NFS server

Your NFS Client enables you to connect to an NFS server that you have access to 
on your network. You can specify NFS servers in the Servers List tab in the NFS 
Client configuration panel, and then use Network Neighborhood to browse for 
the NFS server and volume you want to mount. A volume is a unit of storage, 
such as a folder or directory, that is located on the NFS server you are connecting 
to. To mount a volume means to access the volume.

You must enable your NFS Client and specify an authentication method for the 
NFS server you are connecting to before you can connect to an NFS server.

If you are unable to connect to a server, contact your System Administrator. The 
server might be down, or your System Administrator might not have given you 
appropriate access to the server.

Setting a path for an NFS volume

You can use Windows Explorer in Windows 95 or Windows NT to connect to an 
NFS server if you know the path to the volume you want to mount. Your System 
Administrator can give you the information you need to set up the path.

If you do not know the path to the volume, you can set up servers in the NFS 
Client configuration panel, and use Network Neighborhood to connect. (For 
information about using Network Neighborhood, see “Browsing for an NFS 
volume” on page 3-38).
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To set a path for an NFS volume to mount:

1 From the Start menu, choose Programs.

2 Choose Windows Explorer.

The Exploring window appears:

3 From the Tools menu, choose Map Network Drive.

The Map Network Drive dialog appears, with the next available drive for 
your computer automatically displayed in the Drive field:

4 In the Path field, type two backslashes followed by the path to the NFS 
volume you want to mount (as in the example above).

5 If you want to automatically mount this volume each time Windows is 
started, click “Reconnect at logon”.

6 Click OK.

The Connect Options dialog appears:



File transfer and sharing
Network file sharing

Setting Up IntragyAccess for Windows 95 and Windows NT 3-35

7 In the Username field, type the user name your System Administrator has 
assigned to you for accessing the NFS volume you want to mount.

8 In the Password field, type the password associated with your user name for 
the NFS volume you want to mount. Your password is masked by asterisks 
(*) as you type.

If you want your user name and password to automatically appear in the 
Username and Password fields, configure your global login settings in the 
NFS Client configuration window. (For information about setting global 
login parameters, see “Enabling your NFS Client and setting default user 
information” on page 3-27).

9 In the Buffer Sizes area, type 4096 in both the Read and Write fields.

The default for the Read and Write fields, 8192, is often too high for 
common networks. Lowering the buffer speed helps speed up the 
connection.

10 In the Default File Permissions area, define the types of access that the User 
(the owner of the file), the Group (specific users who have access to the file), 
and Others (anyone else who may encounter the file) can have to the files 
you put on the NFS volume you are mounting:

– To allow the contents of the file or directory to be viewed, click Read. 
No changes can be made to the contents of the file or directory under 
Read access.
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– To allow the contents of the file or directory to be changed, click Write. 
The contents of the file or directory cannot be viewed under Write 
access.

– To allow a program to be run or a directory to be searched, click Exec.

11 In the “Maximum Retransmissions” field, type the maximum number of 
times you want your NFS client to resend information if the server does not 
respond to the initial request. The default value for this field is 3 times. value 
can range from 1 to 127.

12 In the “Timeout for One Transmission” field, type the amount of time, in 
seconds, that you want your NFS client to wait before resending information 
if the server does not respond to the initial request. The default value for this 
field is 2 seconds. The value can range from 1 to 14.

13 To correctly view filenames that contain capital letters, click Enable Upper 
case as default file name.

If Enable Uppercase as default file name is not enabled, any capital letters 
that appear in a filename are represented by an escape sequence and are 
unintelligible to the user. If Enable Uppercase as default file name is 
enabled, any lower case letters that appear in a filename are represented by 
an escape sequence and are unintelligible to the user. 

14 If the NFS server you are connecting to has a Network Lock Manager 
daemon that supports DOS 3.1 file locking/sharing, click Enable DOS 3.1 
Locking/Sharing.

Contact your System Administrator for information about file locking/
sharing support for the NFS server you are connecting to.

15 If you are mounting an NFS volume that is a removable medium on the 
server,( for example a floppy disk or an external hard drive), click 
“Connecting to removable media”.

Enabling Connecting to removable media allows your NFS client to save 
directory and file information into a local cache file instead of having to 
rebuild the information each time you need it. This speeds up the display of 
information. If the removable medium is disconnected, or if the directory 
structure changes, your cache information becomes invalid.

16 In the NIS Domain field, type the domain name that your System 
Administrator has designated for NIS authentication on your network.

17 In the File Access area, define which type of access you have to the files on 
the NFS volume you want to mount:
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– If you have been granted access both to view and change the contents of 
files or directories on this NFS volume, click Read/Write.

– If you have been granted access only to view the contents of files or 
directories on this NFS volume, click Read Only.

18 Click OK.

The NFS volume you specified is mounted, and is identified in the All 

folders area of the Exploring window by a remote volume icon ( ):

19 To view the contents of the NFS volume, double click the volume.

The files and directories on the NFS volume appear in the Contents area of 
the Exploring window:



File transfer and sharing
Network file sharing

3-38 Setting Up IntragyAccess for Windows 95 and Windows NT

Browsing for an NFS volume

Once you have added NFS servers to the Servers List in the NFS Client 
configuration panel, you can use Network Neighborhood in Windows 95 and 
Windows NT to browse the volumes on these NFS servers .

To browse NFS servers with Network Neighborhood:

1 Double-click the Network Neighborhood icon.

The Network Neighborhood window appears:

2 Double-click Entire Network.

The Entire Network window appears:

3 Double-click NFS Servers (FTC).
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The NFS Servers window displays the NFS servers you added to the Servers 
List in the NFS Client configuration window. For example:

NFS servers that you have connected to with Windows Explorer are also 
listed in this window.

4 Double-click the NFS server you want to mount.

The volumes available on that server appear.

5 Double-click the volume on that server you want to mount.

The Connect Options dialog appears:

6 If necessary, change any of the default settings. (For information about 
completing these fields, see Steps 7-17, in “Setting a path for an NFS 
volume” on page 3-33.)

7 Click OK.

The files and directories available on the volume you selected appear.
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Disconnecting from an NFS volume

When you no longer need to access the NFS server you are connected to, close 
the windows associated with that volume.

You are disconnected from the NFS volume you mounted.
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4Using and maintaining Hotlists

After you save information to the Hotlist, you can quickly and easily make 
connections and address email. An assortment of tools helps you organize your 
entries. If you create a lot of Hotlist entries, you might want to create additional 
Hotlists or add folders to existing Hotlists. After you create a Hotlist entry, you 
can edit, rename or remove it.

Using Hotlists
To access the Hotlist, click the (Windows) Start button, and select IntragyAccess 
and then Hotlist.

The main Hotlist window appears. For example:
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In the Name column, the icon at the beginning of each entry corresponds to the 
entry’s type, which is also identified in the Type column. Depending on the type 
of entry, you can double-click on it to establish a Terminal, World Wide Web, or 
FTP session, or address an email message.

The View menu includes commands for sorting entries, and the toolbars provides 
shortcuts to commonly used functions.

Sorting Hotlist entries

You can sort hotlist entries by name or by type and in ascending or descending 
order. First, select the folder containing the entries you want to sort. (The sample 
Hotlist window above has only one folder - the Hotlist folder.) After you click a 
folder, select the View menu. In the View menu:

• To sort by name, select Sort, then Name.

• To sort by type, select Sort, then Type.

• To sort items in ascending order, select Sort, then Ascending.

• To sort items in descending order, then Descending.
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Using the Hotlist toolbar

Table 4-1 shows each button on the toolbar, and describes the action the button 
performs when you click it.

Table 4-1. Hotlist window toolbar buttons.

Button Action

Creates a new Hotlist.

Opens an existing Hotlist.

Saves the current Hotlist.

Cuts the selection and places it on the Clipboard.

Copies the selection to the Clipboard.

Paste an entry you have on the Clipboard.

Undoes the last action.

Deletes the selected item.

Goes up one level in the Hotlist.

Creates a new Hotlist subfolder.

Creates a new Web page Hotlist item.

Creates a new FTP Hotlist item.
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Creating a new Hotlist
IntragyAccess creates a default Hotlist when you install the software. For most 
users, this main hotlist is sufficient. But you might want to create additional 
Hotlists.

To create a new Hotlist:

1 Open the main Hotlist.

2 From the File menu, choose New, then Hotlist.

The New Hotlist’s Folder and Name dialog appears:

3 In the Filename field, type a name for the new Hotlist.

4 In the “Save in” field, navigate the dialog to find the folder in which you 
want to store the entry.

5 Click Save.

Creates a new Terminal Hotlist item.

Creates a new Email Hotlist entry.

Displays the selected items property sheet.

Table 4-1. Hotlist window toolbar buttons.

Button Action
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A new Hotlist main window appears for the Hotlist you just created:

Accessing a new Hotlist
Once you have created new Hotlist files, you can access them through the main 
Hotlist window. To open one of the Hotlists you have created:

1 Open the main Hotlist window (as described in “Using Hotlists” on page 4-
1).

2 From the File menu, choose Open.

The Open dialog appears:

3 Navigate the dialog to find the Hotlist you want to open.

4 Click Open.
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A new Hotlist window appears for the Hotlist you have chosen.

Creating Hotlist folders
To help organize and manage data, you can create folders and subfolders within a 
particular hotlist. To create a new folder:

1 Open the Hotlist.

2 From the File menu choose New, then Folder.

The Folder Properties appears in the Hotlist as an editable text field.

3 In the Name field, type a name for the new folder.

4 Click OK.

A new folder appears with the name you have assigned.

Adding entries to folders

To add an entry to a folder:

1 From the folder list on the left side of the Hotlist window, open the folder 
that contains the Hotlist entry you want to move.

2 Drag the entry into the destination folder and drop the entry.

The item is moved to the new folder.

Removing entries from folders

To remove an entry from a folder:

1 From the folder list on the left side of the Hotlist window, open the folder 
that contains the Hotlist entry you want to move.

2 Drag the entry from the source folder into the main Hotlist window.

The item is removed from the source folder and placed at the location of the 
cursor when you release the mouse button.
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Creating a new Hotlist item
Once you have created a new Hotlist, or if you have decided to use the main 
hotlist, you will want to add entries to the list. IntragyAccess supports Hotlist 
entries for Mail addresses, FTP sites, Terminal hosts, and World Wide Web sites.

Creating a new Mail Hotlist entry

Create a mail Hotlist entry to speed addressing of messages and to address 
messages to groups of recipients. To create a new mail hotlist entry:

1 Open a Hotlist (As described in “Using Hotlists” on page 4-1).

2 From the File menu, choose New then Email Address.

The Create Address dialog appears:

Creating a new Terminal Hotlist entry

You can either of two methods to create a Terminal Hotlist entry, which saves all 
the data required for connection to a particular site. If you currently have a 
session established, you can use the File menu’s Save As command to save the 
data you’ve specified for the current session (for additional details, see “Saving a 
Terminal session as a Hotlist item” on page 2-25).

1 Open a hotlist (as described in “Using Hotlists” on page 4-1).

2 From the File menu, choose New, then Terminal Session.

The New Item Name dialog appears:
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3 Enter a name for the new entry.

4 Click OK.

The Telnet Host Properties dialog appears:

5 Select options for the terminal connection (as described in “Saving a 
Terminal session as a Hotlist item” on page 2-25).

Creating a new FTP Hotlist entry

You can either of two methods to create an FTP Hotlist entry, which saves all the 
data required for connection to a particular site. If you currently have a session 
established, you can use the File menu’s Save Session As command to save the 
data you’ve specified for the current session (for additional details, see “Using 
FTP to transfer files” on page 3-1).

1 Open a Hotlist (as described in “Using Hotlists” on page 4-1).
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2 From the File menu, choose New, then FTP Session.

The New Item Name dialog appears:

3 Type a name for the entry.

4 Click OK.

The FTP Site properties dialog appears:

5 Select options for the FTP connection (as described in “Transferring a file” 
on page 3-13).

Creating a new Web Hotlist entry

IntragyAccess enables you to create and store shortcuts to sites on the World-
Wide Web. To create a Web page Hotlist entry:

1 Open a Hotlist (as described in “Using Hotlists” on page 4-1).

2 From the File menu, choose New, then Web Page Item.

The New Item Name dialog appears:
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3 Type a name for the entry.

4 Click OK.

The Web Page Properties dialog appears:

5 In the field provided, type the URL for the Web page you want to save as a 
Hotlist item.

6 Click OK.

The item is added to the Hotlist.

Editing and deleting Hotlist entries
The IntragyAccess Hotlist program includes functions that enable you to change 
the information stored in a Hotlist entry, rename a hotlist entry, and remove 
entries from the Hotlist.

Editing Hotlist entries

Should you find it necessary to change the information stored in a Mail, 
Terminal, FTP or Web page Hotlist entry, you can access the entry’s properties 
and edit them.
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Editing Mail Hotlist entries

To edit the information stored in a mail hotlist entry:

1 Open a Hotlist.

2 Select the entry you want to edit.

3 From the Edit menu, choose Properties.

The Email Address properties page appears:

4 Edit the information as necessary.

5 Click OK.

The changes are saved to the Mail Hotlist entry.

Editing Terminal Hotlist entries

To edit the information stored in a Terminal Hotlist entry:

1 Open a Hotlist.

2 Select the entry you want to edit.

3 From the Edit menu, choose Properties.

The Telnet Host properties dialog appears:
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4 Edit the information as necessary (for details, see “Editing Terminal Hotlist 
entries” on page 2-26).

5 Click OK.

The changes are saved to the Terminal Hotlist entry.

Editing FTP Hotlist entries

To edit the information stored in an FTP Hotlist entry:

1 Open a Hotlist.

2 From the Hotlist, select the FTP entry you want to edit.

3 From the Edit menu, choose Properties.

The FTP Site Properties dialog appears:
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4 Edit the information as necessary (for details, see “Transferring a file” on 
page 3-13).

5 Click OK.

The changes are saved to the FTP Hotlist entry.

Editing Web Page Hotlist entries

To edit the information stored in a Web Page Hotlist entry:

1 Open a Hotlist.

2 From the Hotlist, select a Web Page entry.

3 From the Edit menu, choose Properties.

The Web Site Properties dialog appears:
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4 To change the address of the entry, click in the Uniform Resource Locator 
(URL) field and enter the new address for the site.

5 Click OK.

The changes are saved to the web page hotlist entry.

Renaming Hotlist entries

You can change the name of any Hotlist entry without opening the properties 
page for the entry. To rename a Hotlist entry:

1 Open a hotlist

2 Select the entry to rename.

3 From the Edit menu, choose Rename.

The selected hotlist entry becomes an active text field.

4 Type the new name for the entry.

The entry is renamed.

Removing Hotlist entries

You can remove entries from the Hotlist by selecting the item you want to 
remove and choosing Delete from the Edit menu. A confirmation dialog appears. 
Click Yes to delete the entry.
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5Using miscellaneous services

IntragyAccess includes the informational utilities Finger, HostLookup, Ping, 
Traceroute and WhoIs. You can use them to obtain information about remote 
hosts and their users.

Using Finger
Most Internet servers at educational institutions (that is, servers with URLs 
ending in .edu) and many Internet servers at other institutions (with URLs ending 
in .org) provide Finger access. When you are connected to such a server, you can 
use the Finger utility to obtain information about users with accounts on the 
server. The information varies from account to account. It usually includes the 
person’s real name and the time of the person’s most recent login, and might 
include a plan file. (Commercial servers rarely provide Finger access)

To use the Finger utility:

1 Click the (Windows) Start bar and select Programs, then IntragyAccess, then 
Network Utilities.

2 Choose Finger.

The Finger dialog appears. For example:
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3 In the “Name@host.host or IP address” field, enter the address you want to 
Finger.

4 Click Finger

The Status area displays the status of the connection to the specified host.

The results of your Finger request appear in the Results area.

Using HostLookup
The HostLookup utility responds to your entry of an IP address by returning the 
name of the host at that address. Or, you can enter a host name to obtain its IP 
address.

To use the HostLookup utility:

1 Click the (Windows) Start bar and select Programs, then IntragyAccess, then 
Network Utilities.

2 Choose HostLookup.

The HostLookup dialog appears. For example:
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3 In the “Host name or IP address to resolve” field, enter the name or IP 
address of the host you want to look up.

4 Click Lookup.

The Status area shows the status of the connection to the specified host.

The Results area shows the host name or IP address of the host you entered 
above.

Using Ping
Ping is a utility that sends echo-request packets to a specified IP address. If the 
host at that address responds, you know that the address is active on the network 
and its host network is functioning normally.

To use the Ping utlity:

1 Click the (Windows) Start bar, and select Programs, then IntragyAccess, 
then Network Utilities.

2 Choose Ping.

The Ping dialog appears:
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3 In the Host field, enter a host name or IP address you want to ping.

4 In the Timeout field, enter the number of milliseconds for which to wait for a 
response before returning a result of not able to connect to host.

5 In the Interval field, enter the time between attempts to send packets of 
information to the specified host.

6 In the Buffer size field, enter the size of the buffer for the packets.

7 In the Iterations field, enter the number of times you want to ping the host.

OR

Click Continuous to continue to ping the host until you click Exit.

8 Click Ping.

The Results area shows the results of the ping.

Using Traceroute
The TraceRoute utility enables you to track packets sent from your computer to 
another host. The results show each host that forwarded packets on the way to 
their destination.

To use the Traceroute utlity:
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1 Click the (Windows) Start bar and select Programs, then IntragyAccess, then 
Network Utilities.

2 Choose Traceroute.

The Traceroute dialog appears:

3 In the Host field, enter the name of the host to which you want to trace a 
route.

4 In the Timeout field, enter the number of milliseconds for which to wait for a 
successful trace before returning an error.

5 In the Buffer size field, enter the size of the buffer to use for sending and 
receiving packets.

6 In the maximum hops field, enter the maximum number of forwarding hosts 
you want in the reported results.

7 To also display information about the host (like in HostLookup) click resolve 
host addresses.

8 Click Trace.

The route from your computer to the host computer appears in the Results 
area.
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Using WhoIs
The WhoIs utility provides another way to obtain directory information about a 
particular user on a given system.

To use the WhoIs utility:

1 Click the (Windows) Start bar and select Programs, then IntragyAccess, then 
Network Utilities.

2 Choose WhoIs.

The WhoIs dialog appears:

3 In the Host to query field, enter the host for the user you are searching for.

4 In the Name to ask about field, enter the username of the person you are 
looking up.

5 Click WhoIs.

The Status area shows the status of the connection to the given host.

Any information available about this user on the given host appears in the 
Results area.
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6Network Printing

For network printing, IntragyAccess includes LPR Client and LPD Server.

LPR Client can send output to any print server that recognizes either the LPR or 
NFS protocol on your network. (LPR--an acronym for Line PRinter--is both a 
protocol for addressing a UNIX print server and a UNIX command for sending a 
file to a printer or other output device)

To use the LPR Client, you must enable it and specify one or more network 
printers, configure Windows 95 for network printing, and connect Windows 95 to 
the network printer. To print to a server that requires NFS protocol, you must also 
redirect a Windows 95 printer port to the printer.

Once you have enabled the LPR Client and connected Windows 95 to a network 
printer, printing to the network printer is as easy as choosing Print from the file 
menu of a Windows 95 program.

LPD Server is a Windows 95 version of the UNIX Line Printer Daemon (LPD). It 
enables your computer to function as a print server for LPR Clients.

Enabling LPR Client
To enable LPR Client:

1 Click the (Windows) Start bar, select Programs, then IntragyAccess, then 
LPR Client.

LPR Client options appear:
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2 Click Enable LPR Client.

3 To add a printer, click the Add Printer tab.

The Add New Printer dialog appears:

4 In the Printer Name field, type the name of the print queue for the printer. 
When connecting Windows 95 to this printer, you will need to enter this 
exact same name, so keep this information handy.

5 In the Printer Domain field, type the fully qualified domain name of the 
printer on your network. This is most commonly the host name of the 
computer acting as your print server.

6 Click OK.

The printer appears in the Printers scrolling list.

Should you find it necessary to remove a printer from the Printers scrolling list in 
the LPR Client configuration panel, select the printer and click Delete.
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Preparing Windows 95 for network printing

To configure Windows 95 for printing on the network:

1 On the Windows 95 Desktop, double-click the My Computer icon.

The My Computer window appears:

2 Double-click the Control Panel icon.

The Control Panel window appears:

3 Double-click the Network icon.

The Network dialog appears:
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If IntragyAccess is configured and connected to a network, TCP/IP and the 
name of your Ethernet card appear in the Network scrolling list. If File and 
printer sharing for Microsoft Network is already listed, proceed to step 12.

4 Click Add.

The Select Network Component Type dialog appears:

5 In the Select Network Component Type scrolling list, select Service.

6 Click Add.

The Select Network Service dialog appears:
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7 In the Manufacturers scrolling list, select Microsoft.

8 In the Network Services scrolling list, select File and printer sharing for 
Microsoft Networks.

9 Click OK.

The Network dialog reappears with the Identification and Access Control 
tabs added.

10 Click the Identification tab.

Identification options appear. For example:
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11 In the Computer Name field, type the name assigned to you by the Microsoft 
Network. If you are not on the Microsoft Network, you can make up a name 
and type it in the Computer Name field.

12 Click OK.

The Network dialog closes, and you are returned to the Control Panel 
window.

Connecting Windows 95 to a network printer

To connect printers in Windows 95:

1 In the Start menu, select Settings, and choose Printers.

The Printers window appears with the Add Printer icon and various types of 
printers listed:
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2 Double-click the Add Printer icon.

The Add Printer Wizard window appears:

3 Click Next.

The following dialog appears:
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4 Click Network printer, then click Next.

The following dialog appears:

5 In the “Network path or queue name” field, type the name of the print queue 
for the printer you want to print to. This should be the exact same name you 
entered in the Printer Name field in the Print Client configuration panel. 

If your network has printers with the same print queue name on different 
hosts, you must type the print queue in the following syntax:

print queue@host name

If you are unsure of where the printer is located, click Browse, and navigate 
to find the printer: 

6 Click OK to display the print queue in the “Network path or queue name” 
field.
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7 In response to the question Do you print from MS-DOS-based programs? 
click No.

Your print client does not support DOS printing under Windows 95.

8 Click Next.

The following dialog appears:

9 From the Manufacturers scrolling list, select the manufacturer of the printer 
to which you are connecting.

If the manufacturer or printer model for your printer is not listed, click Have 
Disk and use your printer installation disks. Alternatively, if you do not have 
the installation disks, consult your printer documentation to find out what 
other printer models are compatible with your printer.

10 In the Printers scrolling list, select the type of printer you are connecting to 
the network, and click Next.
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Depending on the manufacturer and printer type you selected, you might be 
prompted to install new print drivers or to keep existing print drivers for this 
printer. Unless you are sure you want to install new drivers, click Keep 
Existing Driver, and click Next.

11 In the resulting wizard dialog, type a name for the printer in the Printer name 
field. Choose any name that you will recognize as identifying this printer. 
For example:

12 Select Yes or No to specify whether this printer is used as the default printer 
in your Windows applications.

13 Click Next.

The following wizard dialog appears:

14 If you want to print a test page to ensure that the printer is properly 
connected, click Yes.
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15 Click Finish.

The printer appears in the Printers window, confirming that it has been 
successfully connected, and your test page is printed. You can now use the 
Print option in any application in Windows 95 to print to this printer.

Should you find it necessary to remove a printer from the Printers window:

1 Select the printer.

2 From the File menu, choose Delete.

A confirmation dialog appears.

3 Click Yes.

The printer is removed from the scrolling list of printers.

If you delete a printer from Windows 95, you should also delete the printer 
from the IntragyAccess LPR Client configuration panel (as described in 
“Enabling LPR Client” on page 6-1).

Redirecting a printer port

If you are using NFS printing to print to a network printer, you must redirect a 
printer port to the network printer from within Windows 95. (If you are using 
LPR printing to print, you do not need to redirect a printer port.)

To redirect a printer port:

1 From the Start menu, select Settings, and choose Printers.

The Printers window appears with the printers you have configured listed:

2 Select the printer you want to print to.
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3 From the File menu, choose Properties.

The Properties dialog for the printer you selected appears.

4 Click the Details tab.

The port information for the selected printer appears. For example:
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5 Click Capture Printer Port.

The Capture Printer Port dialog appears:

6 From the Device pop-up menu, choose the port to redirect this printer to. The 
next available port appears by default.

7 In the Path field, type the following:

\\host name of print server\queue name of printer

8 To mount the NFS print server for this printer each time you start windows, 
click Reconnect at logon.

9 Click OK.

10 In the Properties dialog, click OK.

The printer port is redirected to the network printer, and you can now use 
your NFS client to print.
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Disabling redirection

Should you find it necessary to disable the redirection of a printer:

1 From the Start menu, select Settings, then choose Printers.

The Printers window appears with the printers you have configured listed. 
For example:

2 Select the printer for which you want to disable redirection.

3 From the File menu, choose Properties.

The Properties panel for the selected printer appears.

4 Click the Details tab.

The port information for the selected printer appears.

5 Click End Capture.

The End Capture dialog appears. For example:

6 Select the printer you want to stop redirection to, and click OK.

Printer redirection is disabled for that printer.
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Setting up LPD Server
Line Printer Daemon (LPD) is a UNIX program providing LPR services. To set 
up your computer as an LPD Server, you enable LPD Server and assign a printer 
to it. You can edit printer information and remove assigned printers as required.

Enabling LPD Server

IntragyAccess allows your computer to act as an LPD server and handle 
incoming print requests from LPR print clients. To enable LPD Server:

1 Click the (Windows) Start bar, and select Programs then IntragyAccess, and 
then choose LPD Sever.

The LPD Server configuration tab appears. For example:

2 Click Enable LPD Server.

3 In the Spool Directory field, type the name of the path to the directory you 
want to use to store spool files created by your print server. A spool file is a 
temporary file that contains all of the information necessary to send your 
print job to the printer.

If you are unsure of the path you want to save the file saved to, click the 
Browse button and navigate the dialog to set the path to the directory. 
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4 Click Open.

5 Select a printer to print the spooled files. (If the current Network Printers list 
is empty, see “Adding a printer to the Current Network Printers list” on page 
6-16.)

6 Click OK.

LPD server is enabled and your computer is ready to receive files for 
printing.

Adding a printer to the Current Network Printers list

To add a printer to the Current Network Printers list:

1 Open the LPD Server configuration tab (as described in “Enabling LPD 
Server” on page 6-15).

2 Click Add.

The New Network printers dialog appears. For example:

3 In the Network Printer Name field, type the official print queue name for the 
printer you are adding. A print queue is a directory that holds output 
designated for the printer until the printer can receive it. It is also the name 
by which you access a printer.

4 In the Windows Name field, type the printer driver that corresponds to the 
printer you are adding.

5 If you want to add a form-feed character after each job, click Send Form 
Feed after job.
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6 If you want to disable the printing of burst pages, click Never print burst 
pages. A burst page is a descriptive introductory page that is printed along 
with a document.

7 Click OK.

The printer is added to the Current Network Printers list.

Editing printer information

If it becomes necessary to edit the information for a printer you have added to the 
Current Network Printers list:

1 Open the LPD Server configuration tab (as described in “Enabling LPD 
Server” on page 6-15).

2 From the Current Network Printers list, select the printer you want to edit.

3 Click Modify.

The New Network printers dialog appears. (For an example see “Adding a 
printer to the Current Network Printers list” on page 6-16.)

4 Change the information as needed.

5 Click OK.

Your changes are saved for the selected printer.

Removing printers from the printers list

If it becomes necessary to remove a printer you have added to the Current 
Network Printers list:

1 Open the LPD Server configuration tab (as described in “Enabling LPD 
Server” on page 6-15).

2 From the Current Network Printers list select the printer.

3 Click Delete.

The printer is removed from the Current Network Printers list.
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ADeskDial

DeskDial makes it possible for data-communications programs, such as terminal 
emulators and fax programs, to use a modem in an Ascend MAX as though it 
were a modem connected directly to the computer.

Most products in the Ascend MAX family can include modems. DeskDial is 
software that enables terminal emulators, fax programs, and other data-
communications programs use MAX modems for outgoing connections. It makes 
MAX modems look and work as though they were connected directly to a 
computer running a data-communications program.

How DeskDial works
DeskDial creates a new COM port that a data-communications program can 
connect to. For almost all of the operations the program performs, this COM port 
behaves just like one of the computer’s built-in COM ports with a modem 
attached. When the program sends data to or gets data from this COM port, 
DeskDial uses a TCP/IP local-area network to transport the data to or from the 
MAX modem. The MAX and the computer running the program must be on the 
same local-area network. Without DeskDial, you would have to assign an 
individual modem to each device as shown in below, or create an analog modem 
pool.
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A better solution is to use DeskDial with modems in a MAX, as shown in the 
next figure. This solution has many advantages:

• Using digital modems in the MAX eliminates problems with line noise and 
the slower throughput of analog modems.

• You can use a single network connection to the MAX for outgoing calls, 
rather than allocating an analog line from a PBX for each modem.

• You can centralize administration of modems by using console-based man-
agement tools.

• Fewer wires and connections simplify troubleshooting.

• The MAX includes security features that let you control access to modems 
and your network.

PC 1 Modem 1

PC 25 Modem 25

PC 50 Modem 50

PC 75 Modem 75

PC 100 Modem 100

PBX

T1
Dial-out Access
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Limitations of DeskDial
You can use DeskDial only for outgoing modem connections. You cannot use it 
for incoming connections to a data-communications program, such as incoming 
faxes.

You cannot use communications programs written for MS-DOS with DeskDial.

What you need to use DeskDial
To use DeskDial, your system must have the right hardware and software. You 
also need information from your system administrator.

Hardware requirements

Each computer that uses DeskDial must have an Ethernet connection to a local-
area network. The network must use TCP/IP network protocols.

PC 1 Modem 1

PC 25 Modem 25

PC 50 Modem 50

PC 75 Modem 75

PC 100 Modem 100

PBX

T1
Dial-out Access
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There must one or more of the following MAX units on the same local-area 
network:

• A MAX 1800, 2000, or 4000 series unit with a digital modem card and TCP/
IP support.

• A MAX 200 Plus with one or more PC Card (PCMCIA) modems.

Note: If a MAX 200 Plus has more than one modem, all the modems 
should be the same type. DeskDial cannot specify which of the MAX 200 
Plus modems to use, and using identical modems ensures that any modem 
initialization that is required will work for any of the modems.

See the Read Me file included with your version of DeskDial to find out what 
version of the MAX software is required.

To use fax software, the modems must have Class 2 fax capability. For a list of 
currently supported modems and their capabilities, see the Ascend World Wide 
Web site at

http://www.ascend.com/

DeskDial works best when the computers and MAX are on the same segment of 
the local-area network (that is, with no bridges or routers between them) and 
when network traffic on the segment is not unusually high. The performance of 
DeskDial is often acceptable when there are one or more intervening bridges or 
routers, provided that the bridges or routers or heavy network traffic do not 
significantly delay the transmission of data. Delays in the transmission of data 
can reduce the maximum speed of a communications program. If the delays are 
severe, a communications program can lose its connection to the MAX modem.

Software requirements

! Caution: Using the wrong version of DeskDial for your operating system 
can cause serious problems, including damage to your system software.

To use DeskDial, your computer must be properly configured for connecting to a 
TCP/IP network. You can use the TCP/IP software that is built into Windows 95 
or other TCP/IP software that uses the Microsoft Transport Driver Interface 
(TDI). For information about configuring the TCP/IP software for your network, 
contact your network administrator.
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Data-communications programs you use with DeskDial must communicate with 
a COM port (such as COM1 or COM2) rather than directly with your computer’s 
serial communications hardware. Nearly all communications programs written 
for any version of Microsoft Windows communicate with a COM port; 
communications programs written for MS-DOS, which are not supported by 
DeskDial, do not.

Data-communications programs you use with DeskDial must also use hardware 
flow control (RTS/CTS) when communicating with a MAX modem. Most fax 
programs use software flow control (XON/XOFF) by default, and you must 
change this setting before using any of these programs with DeskDial.

Fax programs you use with DeskDial must support Class 2 fax modems as well 
as hardware flow control. Fax programs that work with DeskDial for Windows 95 
include:

• WinFax PRO from Symantec (formerly Delrina)

• QuickLink II from Smith Micro

• Microsoft Fax (included in Microsoft Exchange for Windows 95)

• QModem Pro for Windows 95

• FaxWorks from SofNet

If you are using DeskDial with a MAX 200 Plus, you can also use fax programs 
included with any PC Card (PCMCIA) modems that are supported by the MAX 
200 Plus and that allow Class 2 fax operation. For a list of modems that are 
currently supported and to find out which ones support faxing, see

http://www.ascend.com/products/max200plus/pcmcialist.html

on the Ascend Communications World Wide Web site.

Getting information from your system administrator

Before configuring DeskDial or any communications programs, get the following 
information from your system administrator:

• The numbers of the COM ports on your computer and whether they are cur-
rently being used.

Most computers have at least two COM ports, normally COM1 and COM2, 
and many have four. There is a COM port for each external serial connector 
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that is currently enabled (most computers have two of these). There can also 
be COM ports for internal serial devices, such as an internal modem card or 
a bus mouse controller card.

• If there is more than one MAX on your local network, the name of the MAX 
to connect to.

• If the MAX is not in the same subnet as your computer, the IP address of the 
MAX.

• The immediate modem port to use on the MAX.

• Your user name, if a user name is required to use the MAX modem.

• A password, if one is required to use the MAX modem.

• If you are using modems in a MAX 200 Plus unit, the brand and model of 
the PC Card modems installed in it.

Setting up DeskDial 
You install and setup DeskDial using different Windows wizards that enable you 
to follow the steps necessary to successfully complete the installation. There are 
two main steps to setting up DeskDial:

1 Assign a port to a MAX.

2 Set up a modem to use the virtual COM port.

Assigning a port to a MAX

You must now assign the virtual COM port DeskDial to a MAX. To assign a port 
to a MAX:

1 Click the (Windows) Start button, select Settings, then Control Panels.

The Control Panels window appears:
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2 Double-click the DeskDial Ports icon.

The DeskDial Ports dialog appears:

3 Select the DeskDial Serial Port and click Configure to set up the Port.

The DeskDial Properties window appears:



DeskDial
Setting up DeskDial

A-8 Setting Up IntragyAccess for Windows 95 and Windows NT

4 Select “Assign this port to an Ascend MAX.”

The fields in that area become active.

5 If you know the IP address of the MAX you want to use, type it into the IP 
Address field. 

If not, click Find. DeskDial searches for any NAX connected to your subnet 
running the necessary code to use DeskDial. The Find MAX dialog shows 
the results. Select the MAX you want to use and click OK.

6 Set the immediate modem port to the port assigned to you by your system 
administrator.

7 If this MAX requires a user name and password, enter them into the 
appropriate fields.

8 Click OK.

9 The DeskDial Ports dialog reappears showing the configured DeskDial port. 
For example:
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10 Click Close to close the DeskDial Serial port setup utility.

You have now assigned the virtual COM port you created to an Ascend 
MAX.

Setting a modem to use the DeskDial port

The final step in setting up DeskDial is to set a modem up to use the DeskDial 
port you have assigned to a MAX.

1 Click the (Windows) Start button, select Settings, then Control Panels.

2 In the Control Panels window, double-click the Modems icon.

The Install new modem dialog appears:

3 Select “Don’t run the Hardware Installation Wizard.”
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4 Click Next.

A dialog appears where you can search for a modem:

5 Select “Don’t detect my modem; I will select it from a list.”

6 Click Next.

7 A dialog appears showing the Manufacturers and Models of different 
modems:

8 Click the Have Disk button.

The Install from Disk dialog appears:
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9 If you know the location and name of the driver files, type the path name to 
the file. If not, click Browse. A standard Open File dialog appears:

10 A list of driver files appears when you navigate a path to the DeskDial 
directory.

11 Select a file and click OK.

The Install From Disk dialog reappears.

12 Click OK.

13 Click Next.

The modem models dialog appears with the Ascend modem models. For 
example:
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14 Select the appropriate model and click Next.

The wizard displays the following screen:

15 Select the DeskDial Serial Port you created in “Assigning a port to a MAX.”

16 Click Next.

The Location Information dialog appears:
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17 Fill out the fields in this dialog with the appropriate information for your 
location.

18 Click Next.

The Modem Properties dialog appears with the information for the modem 
you have just configured:

When this dialog appears, you are finished setting up DeskDial. Now you can use 
the DeskDial virtual COM port and modem to connect to any location using 
Dial-up networking.
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Configuring a communications program
to use DeskDial

To configure a communications program to use DeskDial:

1 When requested, specify a COM port for connecting the modem, enter the 
COM port you created when you configured DeskDial.

2 If you need to choose a modem type:

– If you are connecting to a MAX other than a MAX 200 Plus, choose 
Supra V.34, Zoom V.34, Generic Rockwell Modem, or some other 
modem that uses the Rockwell V.34 chipset.

– If you are connecting to a MAX 200 Plus, choose the brand and model 
of the PC Card modems installed in the MAX 200 Plus.

Note: If the communications program does not include a choice for the 
modem you are using in a MAX 200 Plus, you might need to enter a custom 
initialization string for the modem. To obtain this string, see the reference 
information for your modem, or contact your system administrator or 
modem manufacturer.

3 Make sure that the initialization string for the modem includes a command to 
enable hardware flow control (RTS/CTS) for your modem.The following 
table shows the commands required for various modems.
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Enabling hardware flow control in WinFax PRO

To enable hardware flow control in WinFax PRO, include the following line in 
the [General] section of the file WINFAX.INI, located in either the Windows 
directory or the WinFax directory:

HdwFlowControl=1

Configuring fax software for a Class 2 fax modem

You can use DeskDial to send faxes only if your fax software is configured to 
work with a Class 2 (or 2.0) fax modem. You cannot use fax software that 
supports only Class 1 fax operation. The following instructions explain how to 
configure QuickLink II from Smith Micro for Class 2 fax operation. To find out 
how to configure other fax programs for Class 2 fax operation, see the 
documentation for the program or contact the manufacturer.

To configure QuickLink II from Smith Micro for use with a Class 2 fax modem:

1 Install the program but do not run it. If you have already run the program, 
delete the SMSSETUP.DAT file in the QuickLink II directory before 
proceeding. Note, however, that this deletes other information such as phone 
book entries and cover page settings.

2 Use EDIT or another text editor (not a word processor) to open the 
SMSSETUP.DAT file in the QuickLink II directory

Chipset used in modem Command to include in modem 
string

Rockwell (used in most inexpensive 
modems as well as the digital 
modems for any MAX other than the 
MAX 200 Plus)

&K3

AT&T \Q3

US Robotics &H1&R2
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3 Search for and delete all lines containing ForceFaxClass.

4 In the [Setup Options] section, find the following line:

AvailableFaxClass=1

5 Change this line to

AvailableFaxClass=7

Configuring a MAX for DeskDial
All MAX 200 Plus and MAX 800 units support DeskDial.To make the modems 
in a MAX available to DeskDial:

1 In the Edit window of the VT100 interface, open the Ethernet > Mod Config 
> TServ Options menu.

2 Set Immediate Modem to Yes.

3 Set Imm. Modem Port to a value between 5000 and 65535 that is not already 
used to specify a TCP/IP port.

This can be any value in this range. When users configure DeskDial, this is 
the value they enter for Immediate Modem Port.

4 Set Imm. Modem Access to the type of authentication required for using the 
modems.

Note: Not all these authentication modes are available in MAX software 
earlier than version 4.6Ci17. See the Read Me file included with your ver-
sion of DeskDial to find out what version of the MAX software is recom-
mended.

5 If a password is required for either Global or User authentication, set Imm. 
Modem Pwd to Yes.

6 If you chose User as the value of Imm. Modem Access, you must enable 
modem dialout in the profile for each user to whom you grant modem 
access:

– In a Connection profile for the user, set Dialout OK to Yes.

– In a RADIUS profile for the user, set Ascend-Dialout-Allowed to Yes.
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Glossary

alias— An additional and optional name used to refer to the host.

ARP— Address Resolution Protocol. Address Resolution Protocol. This portion 
of the TCP/IP protocol maps an IP address to the physical address (Ethernet 
Address) of the PC that it is on, helping to identify PCs on an Ethernet LAN. See 
also Ethernet, TCP/IP, and proxy ARP. 

ASI— Asynchronous SCSI Interface. A type of driver commonly used in LAN 
environments. See also SCSI.

baud— The signalling rate of a line. It is the number of transitions that are made 
per second. Not the same as bps.

baud rate— The speed at which information is transferred through a serial port.

boot— To start or restart your computer.

BOOTP— BOOTstrap Protocol. A protocol that provides a way for a host to find 
its IP address. It also provides the address of a bootserver, of an intervening 
gateway (if present), the subnet mask, and addresses of domain name servers. 
Compare with RARP server.

bps— Bits per second. A measure of the rate of data transmission. Not the same 
as baud.

character— Any symbol that has a widely understood meaning and can convey 
information. Some characters (such as letters, numbers, and punctuation) can be 
displayed on the monitor screen and printed on a printer. Compare with control 
character.
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character set— A group of unique symbols and codes.

client— A program or computer that requests services from a network or server. 
The client provides the user interface and performs some or most of the 
application processing. See also server.

client-server— The methodology of interaction between hosts in a distributed 
system in which one host sends a request to another host and waits for a response. 
The client is the originator of the request, the server is the responder.

command prompt— The characters displayed at the beginning of the 
command line that indicate your computer is ready to receive input. Also known 
as an MS-DOS prompt.

connection— A path that provides reliable delivery stream service between two 
protocol modules.

control character— A non-printing character used to control or modify the 
way information is printed or displayed. Also called control code.

data bit— The number of bits used to represent a single character.

dialing— Connecting to a network by using a modem, which dials over a 
standard telephone line.

DDP-IP— An AppleTalk-to-Ethernet (or other network) gateway that supports 
TCP/IP and AppleTalk protocols, and can understand IP packets encapsulated 
inside AppleTalk packets. This is the only way to run TCP/IP over LocalTalk, 
which is where DDP-IP gateways are generally used.

default— A standard setting or action taken by hardware or software if you have 
not specified otherwise.

domain— A part of the Internet naming hierarchy, consisting of a series of 
names separated by periods. For example, in the host name 
abcd.intragyaccess.com, abcd is in the domain intragyaccess, 
and intragyaccess is in the domain com.
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DNS  server— Domain Name Service Server. An online distributed database 
responsible for mapping host names to their respective IP addresses. Also refers 
to Domain Name Server.

driver— Software that connects a standard operating system interface to a 
peripheral device.

expect string— A string that your script waits to receive before sending a 
response. See also send string.

flow control— The process that determines the rate at which information is 
transferred from one device to another. Also called hardware handshaking.

gateway— A computer that interconnects two different types of networks by 
performing the protocol conversion . See also network.

group— A collection of applications, accessories, or documents within Windows 
Program Manager. Used for organizing your system.

hardware handshaking— The process of negotiations between two devices in 
preparing for data transfer. Compare with flow control.

host— A computer that participates in a data communication network.

host name— The name of a computer that participates in a data 
communications network.

ICMP— Internet Control Message Protocol. The part of IP that handles error and 
control messages. It is used by gateways and hosts to report problems with 
datagrams and their source. ICMP includes an echo request/reply to test the 
availability and status of a destination.

initialization files— Files that contain information defining your Windows 
environment. Their names end with the .INI extension.

interface— A configured driver that is used by the TCP/IP stack in Windows.

internet— A collection of interconnected packet switched networks that 
function as one large virtual network by adhering to common protocols.
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Internet— The collection of gateways and networks that use the TCP/IP protocol 
suite and operate as a single, virtual network.

intranet— The operations within a particular network.

IP— Internet Protocol. The DARPA Internet standard protocol that defines the 
Internet datagram as the unit of information passed across the Internet, and 
provides the basis for connectionless, best-effort delivery service.

IP address— The 32-bit address assigned to a host using TCP/IP to 
communicate over the Internet. See also TCP and IP.

kernel— The portion of an operating system that performs such functions as 
allocating hardware resources.

LAN— Local Area Network. Any physical network technology operating at high 
speed over a short distance. Operational speed ranges from a few Mbps to several 
Gbps.

local echo— In terminal emulation, local echo is the act by the computer or 
terminal of displaying a typed character at the same time that the computer or 
terminal sends the character to the host computer.

loopback local host— A host that performs loopback testing. It is a host that 
transmits a signal that passes through the network and returns to the sending 
device. It is used for testing purposes only.

machine name— A string of characters that serves as the unique name of your 
PC (not the fully-qualified domain name). Also known as host name.

macro— A series of keystrokes and/or commands that have been recorded and 
assigned a name or key combination. When the name is called or the key 
combination is pressed, the macro is executed. Macros can store up to 255 
characters.

MacTCP ®—An ethernet driver for networked Macintosh computers.

MIB— Management Information dataBase. A network data management standard 
used by SNMP databases.
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modem— A device that converts serial digital data from a transmitting terminal 
to a signal suitable for transmission over telephone lines. The modem will also 
convert the telephone signal (analog) into a serial digital signal for use by another 
computer or terminal.

NDIS— Network Driver Interface Specification. A driver commonly used in 
LAN environments.

netiquette— (Network etiquette) The unwritten rules of politeness on the 
Internet.

network— A system of computers and peripherals connected by transition 
media and capable of communication.

NIS— Network Information Service. Server software that provides centralized 
user authentication and information services.

ODI— Open Data link Interface. A driver commonly used in LAN environments.

operating system— A program that organizes the actions of the parts of the 
computer and its peripheral devices.

OT— Open Transport. A multipurpose network ethernet driver for Macintosh 
computers.

parameter— A value that customizes an application.

parity— An error-checking method that makes one bit of each byte unavailable 
for data transmission.

password— A combination of alphanumeric characters used as a security 
measure against unauthorized access to data.

peripheral device— A hardware device (such as a video monitor, disk drive, 
printer, or modem) used in conjunction with a computer and under the 
computer’s control. Peripheral devices are often, but not necessarily, physically 
separate from the computer and connected to it by wires, cables, or some other 
form of interface.
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PPP— Point-to-Point Protocol. A standard that allows multiple LAN protocols to 
be used simultaneously over a modem line or other serial connection.

protocols— Rules governing transmission and reception of data.

RARP server— Reverse Address Resolution Protocol server. A server that runs 
the Reverse Address Resolution Protocol, which is the Internet Protocol used by a 
diskless computer to find its IP address at startup. The diskless computer 
broadcasts its physical hardware address. The RARP server then responds to it by 
sending the machine its network address.

RIF— Routing Information Field. An interior gateway protocol used by some 
UNIX systems to exchange routing information among a small number of hosts.

RIP— Routing Information Protocol. A protocol that allows your computer to 
determine what route a message follows to arrive at its final destination.

RFC— Request for Comments. A series of notes that contain information about 
the Internet, including proposed and accepted TCP/IP protocol standards.

RTT— Round Trip Time. The amount of time it takes a single datagram to leave a 
machine, reach its destination, and return to the source machine.

script— A type of program that consists of a set of instructions to an application 
or utility program.

script file— A file used for automating your sessions with remote hosts.

SCSI— Small Computer System Interface. A specification of mechanical, 
electrical, and functional standards for connecting peripheral devices (such as 
certain kinds of hard disks, printers, network devices, and optical disks) to small 
computers.

send string— A string that your script transmits after receiving the expect 
string. The send string, in turn, prompts the next expect string. See also expect 
string.

serial port— A connector used to attach a modem, mouse, scanner, or other 
serial interface device to the computer.
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server— A computer on a network that is used by multiple users. Compare with 
client.

session— An active connection between your computer and a remote host.

SLIP— Serial Line Interface Protocol. A specification for using the Internet 
Protocol over a low-speed asynchronous serial line.

SNMP— Simple Network Management Protocol. A network protocol used to 
monitor and control networks and hosts.

stop bit— A bit transmitted after each character in asynchronous 
communications.

string— A data structure consisting of a sequence of characters, usually forming 
user-readable text.

subnet— A LAN that resides within another network.

system software— See operating system.

TCP— Transmission Control Protocol. The Internet transport-level protocol that 
provides reliable, full-duplex stream service upon which many application 
protocols rely.

TCP/IP— Transmission Control Protocol/Internet Protocol. Two communication 
protocols used to connect dissimilar systems. The IP protocol controls routing 
data, and the TCP protocol controls transferring data. See also IP and TCP.

Telnet— The virtual terminal protocol in the Internet suite of protocols. Telnet 
enables you to log into a remote host from your local computer and interact as a 
local user of the remote host.

terminal emulator— Software used to simulate a mainframe or minicomputer 
terminal.

timeout— The amount of time software waits for a response from a local or 
remote host before giving up.
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Token Ring— A 4Mbps or 16Mbps LAN developed by IBM and used primarily 
with IBM PCs and workstations. Token Ring networks have a circular topology 
and pass a token around the circle, giving each machine permission to transmit in 
turn.

WAN— Wide Area Network. A communications network that connects 
geographically separated areas.

Windows DLL— The dynamic link library compatible with Windows.
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editing user accounts 4-23
enabling LPR Client 7-1
enabling the LPD Server 7-15
enabling the NFS Client 4-27
establishing an FTP connection 4-1
extension mapping in FTP Client 4-9

F

File Transfer Protocol. See  FTP 4-1
Finger

installation 1-4
using 6-1

Firewall Support in FTP Client 4-7
folders

Hotlist
adding entries 5-6
creating 5-6
removing entries 5-6

FTP Client
changing directories

local 4-12
remote 4-12

command line mode 4-17
downloading a file 4-13
establishing a connection 4-1
file transfer modes 4-14
file transfer modes, changing 4-14
FTP log mode 4-17
FTP window

command window 4-17
customizing 4-14
local view 4-14
using 4-11
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Manual Connect-Advanced dialog 

4-3
multithreaded transfer 4-6
opening a file 4-14
opening a file in the FTP client 4-14
options 4-5

Confirmation 4-7
extension mapping 4-9
Firewall Support 4-7
general 4-6
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status checking 4-12
toolbars 4-12

changing the display 4-16
creating 4-14
customizing 4-14
deleting 4-17

transfer modes
ASCII (text) 4-14
auto-mode 4-14
binary 4-14

transferring a file 4-13
uploading a file 4-13
using 4-1
verbose status messages 4-6

FTP Server
installation 1-3
modes 4-18
mountpoints

deleting 4-21
editing 4-20
setting remote access 4-21
setting user permissions 4-22

mountpoints, creating 4-19
options

accessing 4-17
general 4-18

setting remote access for a new user 
4-21, 4-23

setting up 4-17
starting the server 4-19
user accounts 4-21

creating 4-21
deleting 4-23
editing 4-23

users 4-21

G

General FTP Server options 4-18
GIN Termination Character 2-15
global login options (NFS) 4-27
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hardware requirements A-3

Host Lookup
installation 1-4
using 6-2

Hotlist
accessing 5-1, 5-5
creating 5-4
creating entries 5-7
entries

adding 5-6
editing 5-10
removing 5-6

folders
creating 5-6

FTP Client 4-4
creating entries 4-4
editing entries 5-12
new entries 5-8

Mail
editing entries 5-11
new entries 5-7

opening 5-1, 5-5
removing entries 5-14
renaming entries 5-14
Terminal

creating entries 2-25
editing 2-26, 5-11
new entries 5-7

Terminal entries 2-25
toolbars

using 5-3
using 5-1
using and maintaining 5-1
Web

editing entries 5-13
new entries 5-9

I

IBM emulation
color mapping 2-12
copying tables 2-29
establishing a connection 2-1
models 2-4
options

general 2-11
printing 2-30
selecting columns 2-29
window 2-12

Installation
compact 1-1
custom 1-2

Finger 1-4
FTP Client 1-3
FTP Server 1-3
Host lookup 1-4
NFS Client 1-3
Ping 1-4
Terminal 1-4
TFTP Server 1-3
TraceRoute 1-4
Who Is 1-4

typical 1-1
ISO 8859/1 character set 2-14
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Keyboard
intercepting characters 2-14
mapping keys 2-18
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launching the FTP Client 4-1
launching the TFTP Server 4-24
lines of scrollback 2-6
Local Echo 2-27
LPD Server

defined 7-1
editing printer information 7-17
enabling 7-15
Network Printers List

adding printers 7-16
removing printers 7-17
setting up 7-15

LPR Client
adding printers 7-2
connecting printers 7-3
defined 7-1
disabling printer redirector 7-14
enabling 7-1
redirecting a printer port 7-11

M

Macros
configuring 2-16
defining 2-17
definition 2-16
in terminal sessions 2-16
key sequences 2-16
special key sequences 2-16
Terminal, tab 2-17

Mail
Hotlist

creating entries 5-7
editing entries 5-11

Manual Connect Advanced dialog
FTP Client 4-3

Manual connection
Terminal 2-2, 2-7

MAX
configuring for DeskDial A-16

Miscellaneous services
Finger 6-1
Host Lookup 6-2
Ping 6-3
TraceRoute 6-4
Who Is 6-6

modems
using with DeskDial A-9

mountpoints
creating 4-19
defined 4-19
deleting 4-21
editing 4-20
setting remote access 4-23
setting user permissions 4-22

multithreaded file transfers 4-6

N

National Keyboard mode 2-13
Negotiation options 2-6
Network File Sharing (NFS).

See NFS 4-26
Network Neighborhood

connecting to NFS severs 4-33
Network Printers List 7-16
Network Printing. SeeLPR Client

See also LPD Server 7-1
NFS Client

authentication information 4-27
browsing for an NFS volume 4-38
connecting to an NFS server 4-33
disconnecting from a volume 4-40
Dynamic Browsing 4-30
enabling 4-27
installation 1-3
Network Neighborhood 4-33
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global login 4-27

redirecting a printer port 7-11
servers
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browsing for a volume 4-38
removing 4-30

setting a path to a volume 4-33
setting up 4-27
using 4-26
Windows Explorer, connecting to 

an NFS server 4-33
NFS server

connecting to 4-33

O

opening Hotlists 5-1, 5-5
options

FTP Client 4-5
Confirmation 4-7
extension mapping 4-9
Firewall Support 4-7
general 4-6

FTP Server General 4-18
NFS Client

accessing 4-27
Authentication 4-28
default connection 4-31
global login 4-27

P

PAGE Command 2-15
Ping

installation 1-4
using 6-3

printers
LPD Server

editing printers 7-17
removing printers 7-17

LPR Client
adding 7-2

Network Printers List 7-16
printing an IBM session 2-30
prompt for destination filenames in 

FTP Client 4-6
Proxy OPEN in FTP Client 4-8

R

Remote access for FTP users 4-21
remote access for FTP users 4-23
removing Hotlist entries 5-14
removing NFS servers 4-30
renaming Hotlist entries 5-14
resetting Terminal values 2-17

S

selecting columns in Terminal 2-29
Send "Abort Output" 2-28
Send "Erase character" 2-28
Send "Erase Line" 2-28
Send "Interrupt Process" 2-28
Send are You There?" 2-28
Send Break 2-28
Send FTP Command 2-28
Send IP Number 2-28
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serial port 2-8
servers list

Dyanamic Browsing 4-30
removing servers 4-30

servers list in NFS Client 4-29
setting up LPD Server 7-15
SITE Host in FTP Client 4-8
starting the FTP Server 4-19
Status

FTP Client 4-12

T

Tektronix emulation
establishing a connection 2-1
options

color options 2-15
configuring 2-14
general 2-10

zooming 2-29
zooming a graphic 2-29

Telnet
establishing a connection 2-2, 2-7

Terminal
advanced connection options 2-5
capturing session data 2-28
commands 2-26
Connect dialog 2-1
connection

establishing a Telnet connection 
2-2

negotiation options 2-6
copying tables 2-29
DEC terminal models 2-4
enlarging a graphic 2-29
establishing a connection 2-1
establishing a Telnet connection 2-7

Hotlist
creating entries 2-25, 5-7
editing 2-26
editing entries 5-11

Hotlist entries 2-25
IBM terminal models 2-4
installation 1-4
keyboard mapping 2-18
options 2-9

general, DEC 2-10
general, IBM 2-11
keyboard properties 2-13
macros 2-16
resetting values 2-17
Tektronix 2-14

printing a session 2-30
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Send menu

Send "Abort Output" 2-28
Send "Are You There?" 2-28
Send "Erase Character" 2-28
Send "Erase Line" 2-28
Send "Interrupt Process" 2-28
Send Break 2-28
Send FTP Command 2-28
Send IP Number 2-28

sending commands to remote host 
2-27

setting up 2-9
Terminal menu 2-27

Backspace sends DEL 2-27
Clear Screen Saves Lines 2-27
Local Echo 2-27

toolbars 2-19
accessing 2-19
adding buttons 2-21
creating 2-20
customizing 2-21
removing 2-24
removing a key 2-23
renaming 2-23
replacing a key 2-23

zooming 2-29
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text (ASCII) file transfer mode 4-14

TFTP Server
as an Windows NT Service 4-25
installation 1-3
launching 4-24
permissions 4-25

creating new files 4-25
reading 4-25
writing 4-25

setting up 4-24

Toolbars
source keys 2-22

toolbars
FTP Client 4-12

changing the display 4-16
creating 4-14
customizing 4-14
deleting 4-17

Hotlist
using 5-3

Terminal 2-19
accessing 2-19
adding buttons 2-21
creating 2-20
customizing 2-21
removing 2-24
removing keys 2-23
renaming 2-23
replacing a key 2-23

TraceRoute
installation 1-4
using 6-4

transferring files using FTP 4-1, 4-13

typical installation 1-1
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Uploading a file with FTP client 4-13
user accounts

creating in FTP 4-21
deleting in FTP Server 4-23
editing in FTP Server 4-23

USER after Log On in FTP Client 4-8
USER userid@host command in FTP 

Client 4-8
using Hotlists 5-1
using the FTP Client 4-1
using the FTP window 4-11
Using the NFS client 4-26

V

verbose status messages in FTP Client 
4-6

volumes
disconnecting from NFS 4-40
setting a path to an NFS 4-33
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Web
Hotlist

creating entries 5-9
editing entries 5-13

Who Is
installation 1-4
using 6-6

Will and Do in Terminal connections 
2-6

Windows 95
connecting network printers 7-6
connecting printers using NFS and 

LPR 7-3
disabling redirection 7-14
redirecting a printer port 7-11

Windows NT Service
TFTP Server 4-25

Z

Zooming in on a graphic in a Terminal 
session 2-29
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